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3 file S& pfs: report 
PFS:FILE is an easy-to-use filing system for 
personal computers. With FILE, you 
organize information in ‘‘forms’’ you design 
on the computer screen. Then you can enter 
data in any order, find it, and print it quickly. 

32 pages per form; 100 items per page 
Retrieve on first item in 2 seconds 

Search 1,000 typical forms in 55 seconds m 
(depends on form) 

Sort and print labels or items 
Search on any combination of items 

| 2,900 forms per diskette m 
(depends on form) 

PFS:REPORT produces easy-to-read tables 
from data you keep with FILE. REPORT 
automatically sorts information 
alphabetically or numerically with totals, 
averages and counts. 

Automatic report formatting =—— 
Calculated columns 

Automatic decimal point alignment 
Alphabetic or numeric sorting 

Automatic page numbering 

MORRIS ELECTRONICS 
41357 West Shaw Avenue 

Petaluma, CA 93711 

Parts Inventory 

Minimum Order: 100 Part #: 1Q-125 

Description: Three Position 
Dimmer Switch 

Supplier:. ABC Inc. 
121 Madison Ave. 
Mountain View, CA 94041 

Quantity On Hand: 60 Price: $1.75 

This form is used to maintain an inventory of PARTS. 

Designed for maximum ease-of-use, the PFS 
Family of Software and your Macintosh will 
get you to work right away, even if you have 
never touched a computer before. 

be ‘I 

@ File Edit Functions Formats 

Parts = 

Page | of the form. ( Find next form 

Part #: (0-125 Hinigue Order: 100 

Description: Three Position 
Dimmer Switch 

Supplier», ABC Inc. 
121 Madison Ave. 
Mountain View, CA 94041 

Quantity On Hand: 60 

Here is the same PARTS inventory form re-created with 
FILE on the Macintosh. 

Parts Inventory Control List 

Part # Description OnHand PriceEa. Value 

EMER 
Coax Cable 1,000 Ft. 1.10 1,100.00 

CT-3 Twisted Cable 10 Spools 18.00 180.00 

D/3-15 MailingJackets 325 6.22 2,021.50 

Three Position 60 7S) 105.00 

Dimmer Switch 

Total: 3,492.75 

Count: 5 

age 1 

BIO OOOO OOD OOO OlIO DOO OOO 

5 i 
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This inventory report was printed using REPORT and data 
from the PARTS file maintained with FILE on the 
Macintosh. 

Required: 128K Macintosh Computer 
System 
Recommended: Second disk drive (for files 
with 1,000 or more forms) 

Software Publishing Corporation 
1901 Landings Drive, Mountain View, CA 94043 
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The easy way to greater productivity. 
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Take the work out 

of paperwork. 
Designed for simplicity, PFS 

software puts all the power of 
the computer at the disposal of 
the computer novice. 

PFS programs speak your 
language, so you don't have to 
learn a computer language to 
use them. 
And with PFS software, you 

won't need to remember a lot of 
complicated instructions. Just 
pick the task you want to 
perform from a multiple-choice 
menu, and the software tells the 
computer what to do. 

To make learning easy, every 
PFS software program comes 
with a clear, step-by-step 
instruction manual that guides 
you through each task with 
examples and illustrations. 

Your PFS 
information 
management team. 

PFS software programs are 
completely integrated, so the 
output of one can be the input 
of another. All programs work 
with the same data to save you 
the time and effort of manually 
re-entering information for 
different uses. 

For example, PFS:WRITE can 
personalize a form letter with 
names and addresses from 
PFS:FILE, or include a chart 
from PFS:GRAPH. 

PFS:GRAPH takes data from 
PFS:FILE to produce bar, line 

and pie charts. PFS:REPORT 
creates tables from information 
contained in PFS:FILE. 
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PFS Software Teamwork. PFS 
software programs work 
together to give you powerful, 
integrated solutions to your 
information management 
needs. 

The PFS Family of Software 
offers simple but powerful 
programs that give you the tools 
you need to accomplish almost 
anything you might want to do 
with a personal computer. 

The four basic members of 
the PFS Family of Software are: 
@ PFS:WRITE —- a word 

processing program that’s as 
easy to learn and use as a 
typewriter, but with the 

power of a computer. 
® PFS:FILE — an information 
management program with 
comprehensive filing, sorting 
and searching capabilities. 

@ PFS:REPORT - a 
report-generating program 
that summarizes and 
performs calculations on 
data from PFS:FILE and 
presents it in table form. 

= PFS:GRAPH - a graphics 
program that draws 
presentation quality bar, line 
and pie charts from PFS:FILE 
data, keyboard entry or 
VisiCalc files. 

PFS SOLUTIONS get you off to 
a fast start and help you make 
the most of your PFS software. 
PFS SOLUTIONS give you ready- 
made answers to recordkeeping 
problems, with forms and 
reports already designed for 
you. 

PFS:SCHOOL RECORDKEEPER 
is a SOLUTIONS software 
package designed to handle the 
information management needs 
of school administrators. 

The following pages show 
you how each member of the 
PFS Family of Software can help 
you manage your information 
more easily and efficiently. 

For a free demonstration and 
additional information, visit 

your local PFS dealer and see 
for yourself why PFS software 
has become the most popular 
personal software available 
today. 



pp write 

PFS:WRITE is ideal for busy 
people who want to make their 
writing time more productive. 

PFS:WRITE gives you the 
power of a word processor with 
the simplicity of a typewriter. 
It’s so easy to learn, you'll 
probably begin working 
productively in less than 20 
minutes. All functions are in 
plain English. “Help” 
instructions appear at the 
touch of a key. And the 
instruction manual is clearly . 
written and easy to follow. 

t way to put your ideas 

With PFS:WRITE, what you 

see on the screen is what you 
get when you print. You can see 
just how your document will 
look—where the pages will 
break, how text will appear 
underlined or boldfaced—right 
on the screen. So there are no 
surprises afterwards. 

on paper. 

From draft to final 
in nothing flat. 

PFS:WRITE lets you write, 

correct and revise your 
business letters, memos and 
proposals almost effortlessly. As 
you type, your words appear on 
the screen, which is designed to 

resemble a blank piece of paper. 
You select the task to be | 
performed from a multiple- 
choice menu. 

Should you make a mistake or 
decide to change the order of 
your text, you can make 
changes with just a few 
keystrokes. The text reformats 
itself to accommodate the 



changes. Later, if revisions are 
needed, search and replace 
power at the touch of a key 
makes it easy. 

PFS:WRITE gives your 
documents a professional 
touch with features like 
boldfacing and underlining, 
centering and justification, page 
headings and footings, and 
automatic page numbering. Its 
flexibility lets you adjust the 
page length and margins, print 
single- or double-spaced, even 

address envelopes. And 
PFS:WRITE works with all 
popular printers, so you're not 

locked into a few printer 
choices. 

Enhances your 
other software. 

PFS:WRITE brings out the 
best in your other software 
programs too, whether 
members of the PFS Family of 
Software, or other brands. 

For example, PFS:WRITE can 
use your information from 
PFS:FILE to personalize form 
letters, including addressing 
the envelopes. Further, you can 
illustrate your documents with 
charts created by PFS:GRAPH. 
And with the IBM and 
equivalent personal computers 
version of PFS:‘WRITE, you can 

include tables created with 
PFS:REPORT, or financial data 
from VisiCalc, Lotus 1-2-3, or 
other spreadsheet programs. 

To give you a better idea of 
what you can do with 
PFS:WRITE, on the following 

page are a few examples. 
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With PFS:WRITE, you always see 
right on the screen how your 
finished product will look. This 
is because the screen is 
designed to resemble a blank 
sheet of paper, allowing you to 
see up to 22 lines of text at one 
time. 

With PFS:WRITE, boldface, 
underline, and centering are 
screen-visible, so you can see 
how your document will look 

Further, the status line always 
lets you know what line and 
what page you are working on. 
And if you forget how, “help” 
instructions at the touch of a 
key provide instant assistance. 

right away. And you can easily 
join and edit other documents 
or boilerplate paragraphs as 
you compose. 
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With PFS:WRITE and a 
graphics printer, it’s easy to 
make a good impression. A 
chart like this produced with 
PFS:GRAPH can be inserted 
anywhere, adding drama and 
clarity to your letters. 

All your correspondence can 
be letter-perfect, because it’s so 
easy to make corrections and 

revisions with PFS:WRITE. Once 
revised, text is automatically 
reformatted right before your 
eyes. 



pfs: file 
The simplest way to manage your information. 

No matter what kind of 
information you need to keep 
track of, there’s no easier way 
than PFS:FILE. 

PFS:FILE lets you record your 
information faster and organize 
it more efficiently than 
conventional filing systems. 
What’s more, it lets you retrieve 
and use your information in 
ways that just aren't possible 
with paper and a filing cabinet. 

PFS:FILE works like a paper 
filing system, without the paper. 
With PFS:FILE, your information 
is organized in forms you 
design yourself, to meet your 
own specific needs. 

Once you ve designed a form, 
you just fill in the blanks 
whenever you want to enter 
new information or update the 
old. 

If you change your mind 
about the design of your form, 
or need to add new categories, 
you can change the form easily, 
even after information has been 
entered. 

Keep all your facts 
at your fingertips. 

Because it’s so much easier to 
get at your information with 
PFS:FILE, you'll spend a lot less 
time searching files, and more 
time reviewing and using your 
information. 

With just a few keystrokes, 
you can select for viewing only 
the information you need now, 
and nothing else. For example, 

you can select and review all 
the information that is “less 
than”, “more than”, “equal to”, 

not’, or any “between ’, * 
combination you choose. Or, 



you can choose “all the people 
whose last names begin with C” 
or “all the companies located in 
Chicago.” | 

You can look at all the forms 
that meet your criteria one by 
one, and print the ones youre 
interested in with the touch ofa 
button. Or print selected items 
from your forms, such as names 
and addresses for mailing 
labels, sorted alphabetically or 

by zip code. 

PFS:FILE takes the drudgery 
out of converting your present 
paper filing system to a 
computer-based system, 
because it’s so easy to learn and 
use. Tasks you wish to perform 
are described in simple English. 
You won't need to remember a 
lot of instructions, because you 
select what you want to do from 
a menu on the screen. A 
clearly-written user manual 
guides you through the learning 
process with illustrated _ 
examples. 

Following are just a few 
examples of the hundreds of 
different ways in which people 
have used PFS:FILE to simplify 
their information management. 
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Software Publishing The order/invoice 
Corporation used this form to information entered with 
record daily orders, shipments PFS:FILE was used with 
and cash receipts. The form PFS:REPORT and PFS:GRAPH to 
doubled as the mailed produce all the firm’s monthly 
customer invoice, saving reports on orders received, 
valuable hours of data re-entry. shipments, accounts receivable, 

and receipts. 

A sales manager in the actual sales. He uses this file 
packaging industry uses with PFS:REPORT to generate 
PFS:FILE to keep track of all product line sales by 
sales representatives and their representative or territory, and 
related product line a comparison of actual sales to 
responsibilities, quotas, and quota for each rep. 
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The local government of a 
major city uses this form to 
keep track of all vehicles owned 
by that government. At any 
point in time, the administrator 

can determine where a certain 

vehicle is, or how many vehicles 

have been rented to which 
departments. 

An avid wine connoisseur 
uses PFS:FILE to keep track of 
the contents of his wine cellar. 
This form allows him to check 
his inventory any time by wine 
type, name of winery, and 
quantity of wine on hand. A 

form like this can be used for 
recording many types of — 
household collections, such as 
art, books, recipes, records or 

tapes, computer games or 

software programs. 



pfs: report 
Reveals the meaning behind your information. 

PFS:REPORT is the perfect 
complement to PFS:FILE. It 
organizes your data into 
meaningful tables, providing 
averages, totals, and counts to 

assist your decision-making. 
Fast and easy to learn, 
PFS:REPORT is a tool that buys 
you time for analyzing your 
information. 

With PFS:REPORT, you can 

produce summaries from your 
PFS:FILE data in a matter of 
minutes. Organizing your facts, 

PFS:REPORT will automatically 
sort rows of information 
alphabetically and numerically, 
generating reports you can use 
for your own review, for 
presentations, or for inclusion 
in written documents. 

There are a variety of ways to 
get at and use the information 
in your PFS:FILE forms. With 
PFS:REPORT, you can 
summarize all of your 
information in columns to give 
you an overview of your data. Or 
you can select specific 
categories of information to be 
included in your report. For 
example, PFS:REPORT could 
sort your accounts payable 
information by billing date and 
give you an up-to-the-minute 
recap of who’s current and 
who's overdue. 
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With just a few keystrokes, 
you can print professional 
looking reports with automatic 
centering, underlining, column 

alignment, titling and page 
numbering. 

Math made easy. 
PFS:REPORT performs 

calculations on your data that 
can reveal new relationships 
among your facts. It figures 

totals, subtotals, averages, 
subaverages, counts and 
subcounts with one or two 
keystrokes, so you don't have to. 
If you want to perform 
arithmetic calculations on 
columns in your report, just 
give PFS:REPORT the equation 
and it will calculate and print 
the results in a new column! 

Together, PFS:FILE and 
PFS:REPORT give you a 
powerful information 
management system you Can 

use to analyze, plan and make 
better-informed decisions. 
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Information from an invoice 

file was used to produce this 
accounts receivable summary 
that shows how much each 
customer owes, the invoice 

number, and when the item 
was shipped. As receivables 
become past due, this report 

can be forwarded to accounting 
for use in collections. 

A report like this tabulates 
sales data to show, by product, 
how much each salesperson 
has sold to date, compared with 

that person’s quota. It also 
computes the average and total 

sales by product, and for all 
products combined. This 
format provides a quick way to 
compare the performances of 
sales reps, or the short-term 

market success of a product. 
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This report is a summary 
listing of every vehicle owned by 
a city government, tabulated 
from information entered and 
updated with PFS:FILE. It tells 
at a glance where each vehicle 

is currently located. Alternately, 
PFS:REPORT could have 
selected from this data a listing 
of all vehicles over two years old 
for use in vehicle maintenance 
planning. 

From PFS:FILE information 

entered whenever a new wine is 
acquired, the wine connoisseur 

can use PFS:REPORT to 

generate this wine cellar 
summary that shows how many 

bottles of each type and year 
remain in inventory. 
PFS:REPORT computed the 
average price of a bottle, the 

number of varieties, and the 

total number of bottles in stock. 



pfs: graph 
Get the whole picture fast. 

PFS:GRAPH is the ideal tool 
for the decision-maker who 
knows a picture is the fastest 
way to prove a point. 

A powerful communication 
and decision tool, PFS:GRAPH 

quickly transforms complex 
facts and figures into 
easy-to-grasp visuals. Visuals 
that aid in decision-making, 

and add eye-opening impact to 
your presentations and reports. 

PFS:GRAPH provides | 
presentation-quality bar, line 
and pie charts, in color or 
black-and-white, in just 

minutes. With no tedious 
calculations or computer 

programming. That’s why it’s 
been called the easiest-to-use 
graphics program around for 
personal computers. 

Computer graphics 
for beginners. 

To create your visuals, all you 
do is specify the kind of graph 
you want, and enter your 
information. PFS:GRAPH does 
the rest. | 

It’s easy to experiment with © 
different types of graphs until 
you find the best way to display 
your data. You can change © 
graph types on the screen, right 
before your eyes, in seconds. 
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You may want to dramatize 
comparisons among data by 
mixing and matching line and 
bar graphs. Stack bar graphs, or 
display them side-by-side for 
comparison. PFS:GRAPH lets 
you put up to four graphs on a 

single set of axes. 
Automatic formatting, 

scaling, legend labeling and 
pattern-fill make it simple to 
create clear, informative visuals 
for sales presentations, 

meetings, reports and 
documentation. 
PFS:GRAPH prints charts in 

two sizes, 3” X 4” or 8-1/2" x 11", 
on several popular graphics 
printers. It also produces color 
plots on paper or 
transparencies via a number of 
popular plotters. 

PFS:GRAPH pays 
its OWN Way. 

PFS:GRAPH can save you 
time, because it works 
hand-in-hand with your other 
software. It uses information 
you enter from your keyboard, 
or retrieves data from PFS:FILE 
forms or VisiCalc files. And with 
PFS:WRITE, you can 

conveniently integrate a chart 
into the body of a letter or 
report. 

Compared with hand-drawn 
graphics, PFS:GRAPH can save 
you enough money on your first 
set of charts to pay for itself. 
Over the course of a few 
months, it could save you 
enough to pay for the computer 
it runs on. Including a printer 
or plotter! | 

Take a look at what you'll be 
able to do with PFS:GRAPH. 
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PFS:GRAPH can plot a pie how much each variety of wine 
chart like this from PFS:FILE > contributes to the total wine 
records of wines purchased for inventory. The percentages are 1 
a wine cellar. This inventory automatically calculated by 
breakdown shows at a glance PFS:GRAPH. | 

This line chart printout data easier to grasp. It can 
provides a quick comparison of _ provide a valuable guide for 
current sales with past sales, future planning. You can also 
month by month. This kind of print the data in columns 
visual presentation can make before the chart. 
the implications of important 

= 

a 
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PFS:GRAPH allows you to 
combine graph types, up to four 
on a single set of axes. The bars 
in this chart show the projected 
shipments of cabernet for each 

month. The line indicates the 

actual number of cases shipped 
to date. Grid lines shown here 

are optional. 

This side-by-side bar chart 
makes assimilation of a large 
amount of complex data easy. 
For each year, this chart shows 

revenues generated by rental of 
each of four different items. It 
highlights the most popular 
items, and shows how their 

sales levels increase from year 
to year. Automatic formatting 

and pattern-fill lets PFS:GRAPH 
produce in seconds a chart that 
would take hours to produce 
manually. 
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Stacked bars are another 
effective way to convey the real 
meaning of numbers. In this 
chart, stacked bars and 
contrasting pattern-fill show 
the geographical distribution of 

subscribers to each of three 
magazines. Automatic scaling 
and legend labeling, plus 
instant calculation of data, 
made this chart a snap to 
produce. 

For a seasonal business like 
toy manufacturing, a 
combination bar and line chart 
like this provides a dramatic 
visual comparison of actual 
receipts versus targeted 
receipts for each month of the 
year. Data for this chart could 

have been entered at the 
keyboard, or taken directly from 
PFS:FILE data or VisiCalc files. 
Plotted output like this can be 
produced on paper or 
transparencies for 
presentations. 
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solutions 

The shortest route to success. 

What could possibly be faster 
and easier than PFS software? 

~ Only PFS SOLUTIONS, a new 
concept in PFS software that 
Saves you time and puts the full 
power of PFS:FILE and 
PFS:REPORT to work for you 
immediately. 
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PFS SOLUTIONS are field- 
tested, ready-made applications 
of PFS:FILE and PFS:REPORT to 
specific recordkeeping tasks, 
including: 
# MAIL LIST 
CHECKS 
EMPLOYEE 
TICKLER 

INVENTORY 

INVOICES 
LEDGER 
PAYROLL 
HOME BUDGET 

HOME INVENTORY 
STOCKS 
DISK LIBRARY 

With each SOLUTIONS 
package you get a complete 
form design, and from three to 

seven predefined 
reports — everything you'll need 
to get started streamlining your 

_ recordkeeping right away. Like 
all PFS software, PFS 

SOLUTIONS forms and reports 
- can be customized to your 
special needs. 

SOLUTIONS are simple to 
learn and use, too. Each 
package comes with clear 
instructions, and gives you 
sample information to 
experiment with before you 
enter your own data. 



To find the right PFS SOLUTIONS for you... 
BUSINESS PERSONAL ; 

© 7 a 
i 2 3 
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rokers and Agents | 7 | 
7 Real Estate, Stock, ® ® @ @ 

Insurance 

rofessional Services 
Lawyer, Doctor, @ 6 ® e e 

Accountant, Consultan 

mall Business 
Retail, Wholesale, @ @ @ e @ @ 

Manufacturing 

wner/Operator ® e ® ® @ ® 

| dministrative Assistant @ ® @ 

upervisor/Manager & 8 e | 

ales Representative e —@ & 
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MAIL LIST. 
Making the most of those 
names and addresses. 

MAIL LIST is the 
easy-to-update alternative to 
the address book, keeping 
current addresses and phone 
numbers always at your 
fingertips. Whether you're 
tracking customers, suppliers, 

sales reps, or friends for 

Christmas cards, MAIL LIST will 

help you manage the details, 
and will even print your mailing 
labels. 

Reports you receive with 
MAIL LIST include: 
# Alphabetic address register 
® Phone listing for home, work, 

and one extra number 
# Phone listing organized 

alphabetically by company 
name, showing contact 

names and extensions 

CHECKS. 
Tracking your cash flow. 
CHECKS makes it easy to 

keep an organized record of 
your banking transactions, so 
vital to managing your business. 
CHECKS also captures invoice 
and purchase order 
information that lets you 
quickly identify the status of 
each invoice, and see just how 

much is outstanding in 
payables at any time. 

Reports included with 
CHECKS are: 
® Sorted check list showing 

date written, payee, and 

amount | 

® Summary and total of checks 
written to each payee 

® Summary and total of checks 
charged to each expense 
account | : 

® Chronological deposit 
record, including bank 
adjustments 

= Invoice and purchase order 
register | 

EMPLOYEE. 
Keeping employee 
information current. 
EMPLOYEE offers a 

convenient way to organize and 
maintain vital information 
about your employees. 
Information like benefit 
entitlements, salaries, social 

security numbers and 
birthdays, that helps you 
manage your workforce 
effectively. 

You receive these reports 

with EMPLOYEE: 
= Employee benefits register 
® Salary review report 
# Employee birthdays 

chronologically, 
cross-referenced by 
Supervisor name 

= Employee directory with 
home and work phone 
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TICKLER. — 
Getting yourself organized. 

TICKLER is the solution for 
the executive on the go. It helps 
organize your daily schedule, 
recording appointments and 
reminding you of commitments 
and deadlines. It also provides a 
handy way to track your ~ 
business expenses. 

These are the reports you ll 
get with TICKLER: 
= Daily appointment schedule 

organized by date and day of 
week 

# Expense log for travel, meals 
and other business expenses 

® Quick-reference list of tickler 
file items due for whatever 
range of dates you specify 

INVENTORY. 
Taking stock of your business 
assets. 

INVENTORY lets you monitor 
your stock on hand to help you 
maintain control over your 
most important assets. 
INVENTORY also calculates the 
profit margin on each inventory 
item, so you can make timely 
price changes to protect your 
profitability. 

Reports you'll receive with 
INVENTORY include: 
® Suppliers list by inventory 

item 
= Purchase register showing 

year-to-date purchases of 
each item 

=# Calculation of profit margin 
on each inventory item 

# Price and item number list 
arranged by product 

INVOICES. 
Managing your receivables. 

With INVOICES you get a 
general-purpose invoice form 
for use in billing your 
customers and in tracking the 
status of customer orders. You ll 
find INVOICES data handy 
when you need to determine 
your total sales, cash receipts, 

and outstanding receivables. 
Reports provided with 

INVOICES are: 
# Sales tax summary that 

calculates accrued tax 
payable to the State 

# Customer analysis that 
shows total sales and number 
of orders by each customer 

® Sales history that lists all your 
invoices chronologically 

# Purchase order register that 
shows the status of all 
customer purchase orders 

® Cash receipts and receivables 
report for each invoice 
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LEDGER. 
Managing your business 
transactions. 
LEDGER is the ideal 

replacement for bulky ledger 
books. Just make your journal 
entries at your computer, and 
youll be all set to prepare 
financial statements and trace 
important transactions. 

With LEDGER youl get these 
reports: 

# A General Journal that shows 
both sides of each entry, and 
whether they balance 

# Account closings for balance 
sheet and income statement 
accounts | 

® Chart of Accounts for handy 
reference to all account titles 
in your bookkeeping system 

PAYROLL. 
Managing your payroll. 
PAYROLL handles the tedious 

work of tracking withholding 
and other payroll information 
for each employee throughout 
the year. And it organizes your 
information so that completing 
government reports is a breeze. 

The PAYROLL form can also be 
printed and used as a payroll 
voucher to accompany payroll 
checks. 

The following reports are 
included with PAYROLL: 
# Summary of taxes 

withheld/due to Federal, 
State and local governments 

# Calculation and listing of W-2 
information for each employee 

# Payroll stub with year-to-date 
information for each employee 

® Calculation of regular and 
overtime earnings for salaried 
and hourly employees 

=® Determination of net pay 
based on earnings and 
deductions entered 

HOME BUDGET. 
Managing your money. 
HOME BUDGET makes it easy 

to track your bank and credit 
card transactions for fast 
reconciliation of your 
checkbook and credit card bills. 
You'll find this information 
useful in establishing a realistic 
budget based on actual 
expenses in the preceding year. 

Reports you receive with 
HOME BUDGET include: 
# Year-to-date and monthly 

expenditures by budget 
category 

® Bank checkbook 
reconciliation 

# Fixed and varying expenses 
# Itemized tax deductions — 
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HOME INVENTORY. 
Tallying your personal assets. 

Youll find HOME 
INVENTORY the convenient 
way to keep track of all your 
personal property, financial 
asset records and valuable 
documents. This information 
can be used for assessing your 
personal and household 
insurance requirements, and, 

with supporting 
documentation, for filing 
insurance and warranty claims. 

You receive these reports 
with HOME INVENTORY: 
# Household property, 

documents and assets by 
location 

® Purchase price and estimated 
current value of personal 
property 

® Tickler reports for review of 
legal documents and renewal 
of investments 

® Serial numbers and warranty 
information 

STOCKS. 
eee ae portfolio 
profitable. 

With STOCK$ you can quickly 
analyze the value of a stock 
portfolio, including realized 

and unrealized gains and 
losses, effective growth rates, 
and dividend yields. STOCK$ 
maintains a record of all shares 
you have purchased and sold, 
showing share location, agent 
and commissions. 

You receive the following 
reports with STOCKS: 
® Current portfolio information 
® Current stock values 
® Unrealized gains and losses 
® Short and long term realized 

gains and losses 
Rank by effective growth rate 
Portfolio performance 
compared with Dow Jones 
index average 

® Portfolio performance 
compared with any other 
user-defined index average 

DISK LIBRARY. 
Managing your 
hardware/software 
collection. 

DISK LIBRARY gives you 
instant access to important 
information about your 
computer hardware, software, 

games, original programs, data 
diskettes and tapes. It’s a handy 
reference for service and 
warranty information. And it 
even prints your diskette labels. 

Reports you receive with 
DISK LIBRARY include: 
® Hardware/software 

expenditures 
® Diskette labels 
® Vendor and 

maintenance/support 
information 

® Software by filing ID number 
® Software by category 
® Hardware serial numbers and 

warranty information 
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solutions 
: school recordkee per 

Simple software goes to the head of the class. 

The PFS:SCHOOL 
RECORDKEEPER is a 
PFS SOLUTIONS product that 
tailors the power and flexibility 
of PFS:FILE and PFS:REPORT to 
the record keeping needs of 
small to medium-sized schools 
and organizations that offer 
regularly scheduled classes. 

It consists of four 
ready-to-use forms and over 30 
standard reports for: 
= student record management 
® budget and requisition 

control 
® property and equipment 

inventories 
® room and event scheduling 

As easy aS ABC. 
Used with PFS:FILE and 

PFS:REPORT, PFS:SCHOOL 
RECORDKEEPER is a 
remarkably simple way to 
computerize your school 
records. It’s so easy to learn and 
operate, anyone in the office 
can begin to use it productively 
within half an hour. 

With PFS:SCHOOL 
RECORDKEEPER, information 

is simply typed into forms that 
appear on the computer screen, 
much like typing information 
into a standard pre-printed 
form, only faster and easier. 

Functions are in plain 
English, and instructions to 

remember are few. Menu 
selection makes it easy to add, 
search, update, retrieve and 
print information. A clear, 
concise instruction guide aids 
learning with examples and 
illustrations. 

Does more work 

with less staff time. 
Reports that might otherwise 

take days to compile by hand 
can be produced in minutes, 
with a few keystrokes. Useful 
reports like student lists, budget 
reports, school and public 
events schedules and more. 
Each one automatically 
formatted, with centered titles, 

ee 



columns of information 
tabulated and aligned, and 
pages numbered. 

Selected items of information 
may also be printed in a variety 
of useful formats, like mailing 
labels, alphabetized lists, or 

index cards. 

Excels at almost 
any task. 

PFS:SCHOOL 
RECORDKEEPER’'s flexibility 
lets you customize forms to 
capture any specific 
information you may want or 
tailor reports to print 
information in whatever order 
you prefer. 

You can also create 
additional forms and reports to 

meet almost any other school PFS:SCHOOL 
information management need. RECORDKEEPER takes the 
So you can save the money you paperwork load off your staff's 
would have spent on avariety of | desks and puts it through the 
single-purpose software computer, where it belongs. 
programs. What’s more, with 
only one set of operating 
instructions to learn, you cut 
down the time and expense of 
training your staff. 
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The Student Record 
Management component of the 
PFS:SCHOOL RECORDKEEPER 
gives you quick access to all 
basic student information 
needed for daily school 
operations, from homeroom 
and counselor assignments to 
emergency information, from 
busing lists to vaccination 
records, from enrollment and 

ethnic data to special program 
registration. 

With the Budget and 
Requisition Control component 
of the RECORDKEEPER, you'll 
get detailed status reports on 
each budget account and 
subaccount to supplement the 
monthly district budget 
printouts with 
up-to-the-minute information. 

Reports include: 
@ parent mailing labels 
# homeroom, counselor and 

locker information 
student lists 
student/parent information 
teacher class report 
student emergency data 
vaccinations needed 
student busing report 
test score warnings 
special program registration 
dominant language report 

Reports include: 
® YTD budget balance for all 

departments 
# YTDbudget | 

balance —accounts within a 
department 

® outstanding requisitions YTD 
® overdue deliveries 
® items returned for credit 

a ee 
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The School Property 
Management component of the 
RECORDKEEPER gives you 
ongoing control of all school 
property, including audiovisual 
equipment, P.E. equipment, 
musical instruments, 

computers, office machines, 
and more. 

Reports include: 
school property report 
property by location 
property by funding source 
property values by category 
property being repaired 
repair cost analysis 
maintenance cost analysis 
property on loan 

With the Room and Event 
Scheduling component of the 
RECORDKEEPER, you ll find it 
easy to get complete scheduling 
information on classrooms, 

after-school and sport events, 
summer and vocational 
education programs, and 

community affairs. Also 
included are revenue reports 
and operations calendars for AV 
and custodial staff. 

Reports include: 
master room report 

teacher locator by class 
period 
master report by type of room 
room fixtures locator 
public events calendar 
special events operations 
schedule 
projected revenues from 
public events 
event sponsors — accounts 

receivable 
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The PFS Family of Software is currently available 
in the following versions: 

PFS: 

SCHOOL 
PFS: PFS: . PES: PFS: PFS RECORD- 

WRITE FILE REPORT GRAPH SOLUTIONS KEEPER 

Apple II ® ® @ ® 

Apple Ile e @ @ & @ ) 

Apple III @ @ ® ° 

IBM and e @ ® @ 6 

equivalent 
personal 
computers 

Texas 6 @ @ ®@ 

Instruments , 
Professional 

Computer 

TRS-80 ® 

Model III and Model 4 

Additional hardware and software requirements are listed on the back of each PFS software package. 

Affordably-priced PFS software, PFS: SCHOOL RECORD- information and a free 

with suggested retail pricing of KEEPER), is available in local demonstration of what PFS 
$125 to $175 ($20 for each PFS computer hardware and software can do for you, visit 

SOLUTIONS product except software retail stores. For more your local PFS dealer today. 
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Support Policy 
To participate in Software Publishing’s support service, fill out and return 

the User Group Enrollment card. 

Warranty: Software Publishing Corporation warrants that the PFS program 

disk is free from defects in material and workmanship, assuming normal 

use, for a period of ninety (90) days from date of purchase. If a defect 

occurs during this period, you may return your disk to Software Publishing 

or its authorized dealer, along with a dated proof of purchase, where it will 

be replaced free of charge. 

Program Updates: Software Publishing will notify you of all program 
updates. These new versions may be obtained from Software Publishing 

Corporation or its participating dealer by returning your current disk along 

with a check in the amount specified in the notification letter. 

NOTICE 

EXCEPT FOR THE EXPRESS WARRANTY SET FORTH 
ABOVE, SOFTWARE PUBLISHING GRANTS NO OTHER 
WARRANTIES, EXPRESS OR IMPLIED, BY STATUTE 
OR OTHERWISE, REGARDING THE DISK AND 
RELATED MATERIALS, THEIR FITNESS FOR ANY 
PURPOSE, THEIR QUALITY, THEIR MERCHANTABIL- 
ITY, OR OTHERWISE. 

THE LIABILITY OF SOFTWARE PUBLISHING UNDER 
THE WARRANTY SET FORTH ABOVE SHALL BE 
LIMITED TO THE AMOUNT PAID BY THE CUSTOMER 
FOR THE PRODUCT. IN NO EVENT SHALL 
SOFTWARE PUBLISHING BE LIABLE FOR ANY 
SPECIAL, CONSEQUENTIAL, OR OTHER DAMAGES 
FOR BREACH OF WARRANTY. 

©1984 Software Publishing Corporation 
| July 1984 

Software Publishing Corporation 
1901 Landings Drive 

Mountain View, CA 94043 
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about this manual 
Rear errr rarer eee 

PFS:REPORT is one of a series of easy-to-use programs in the PFS 
integrated Family of Software. This manual explains how to use 
PFS:REPORT to prepare and print tabular reports of your own design, 
using the information you have stored with PFS:FILE. 

To learn PFS:REPORT, you first need to know how to use your Macintosh. 
In particular, you should know how to use the mouse, the keyboard, and 
pull-down menus; how to drag the pointer; and how to select an icon. You 
can perform some PFS:REPORT tasks in more than one way using these 
features of the Macintosh; however, to simplify instructions, this manual 
suggests one technique for each task. Refer to Macintosh, the owner’s 
guide, to learn the full range of its capabilities. 

This manual contains six chapters and two appendices. The chapters give 
detailed instructions and examples for using PFS:REPORT. Information that 
appears on your Macintosh screen is presented in boldface type to 
distinguish it from other text. The best way to learn PFS:REPORT is to 
read the manual and work through the examples on your Macintosh. 

The appendices contain instructions on correcting errors and the example 
file used throughout the manual. A quick reference guide and an index are 
also included. 

If you have not already done so, please fill out and return the User Group 
Enrollment Card. Enrollment in this group entitles you to receive product 
update information and tips on using the PFS Family of Software. 
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About PFS:REPORT 
PFS:REPORT is a computer program that enables you to produce tabular 
reports from your PFS data files. If you are familiar with PFS:FILE, you 
already know a lot about how to use PFS:REPORT. 

A report can have up to 20 columns. In preparing a report, PFS:REPORT 
plans the layout of each page to take the best advantage of the available 
space. It can sort the information in your files alphabetically or numerically, 
and it can perform calculations on numeric information. 

Suppose you have the purchase history of all the items in your inventory 
_ stored in a PFS file named PARTLIST. The blank form might look like this: 

"  @ File Edit Functions Formats 

Se PARTLIST 

{Page 1 -- please choose forms for the report. Print report |f 

- Part #: Date Purchased: 

= Description: 

a Quantity: 

. Supplier: 
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The following report (listing all items purchased in the last month) is just 
one example of a report that can be produced from the PARTLIST file 
using REPORT. 

INVENTORY LISTING 3/12/83 

Description Quantity Price Supplier 

4" lag bolts 5 Johnson Mfg. 

cedar shingles A Rooftex 

4 inch bricks 5 Brickmart 

ceramic tile : Tilecomp 

Notice the title line. One appears on each page of a PFS report. Notice 
also that the name at the top of each column of the report corresponds to 
an item name from the PARTLIST form. Each horizontal row in the report 
contains information from one form in the PARTLIST file. 

Let’s look at another report generated from PARTLIST: 

PARTS IN STOCK 

Description Quantity 

4" lag bolts 

cedar shingles 

4 inch bricks 

ceramic tile 
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This is a fairly simple report. Part # again appears as the first column. 
REPORT has arranged the rows in ascending order (smallest to largest) by 
part number and has also counted the entries in the first column to give 
you the number of different parts in stock. When REPORT sorts the rows 
of a report alphabetically or numerically, it does so according to the 
information in the first two columns. If the information in the first column is 
the same for two or more rows, PFS:REPORT sorts those rows by the 
information in column two. PFS:REPORT can total, average, or count the 
number of items in a column. It can also give subtotals, subaverages, and 
subcounts. 

The following report contains a vertical column name (Value) that does not 
correspond to an item name in the PARTLIST form: 

TOTAL VALUE OF INVENTORY 

Description Quantity 

4" lag bolts 

cedar shingles 

4 inch bricks 

ceramic tile 

In this report, PFS:REPORT calculated the Value column by multiplying the 
Price and Quantity columns together. You can have up to three such 
derived columns in a report. 

How PFS:REPORT Works 
The PFS:REPORT program has three main capabilities. These are Print a 
report, Create a report format, and Change headings. To print a report or 
change headings, you pull down the Functions menu and choose the 
command you want. To create a report format you pull down the Formats 
menu and choose the Create a report format command. 
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You use the Print a report function to produce reports from your PFS files. 
The three-step operation lets you choose which forms from the file you 
want in the report, set up your printer to your specifications, and then 
specify which items of information go in which columns and how they are 
to be treated. When you have completed these three steps, your report is 
printed. 

lf you want to use the same report format more than once, Create a report 
format lets you store the third step of the above process so that you do not 
have to repeat this step every time you print a report. For instance, you 
could store the three report formats shown above and use them to print 
periodic, up-to-date reports on your inventory. You give the stored report 
format a name, and from then on just choose the name of the predefined 
format and immediately print the report. You can store up to eight report 
formats for each PFS file. 

Headings are automatically generated from the item name in your file. The 
Change headings function enables you to alter the headings on your 
report to something other than the item names. This change is especially 
desirable when an item name is substantially longer than any of the entries 
in the column. REPORT makes it easy to change any column heading in 
the report. For example, in any of the above reports you might want to 
shorten the column heading from Quantity to Qty. 

The remaining chapters of the PFS:REPORT manual give you detailed 
explanations and examples of how to prepare reports, from simple ones to 
more complex ones with column calculations and derived columns. You 
also learn how to save your report formats and set the headings you want 
on your reports. 
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This chapter explains how to get started using PFS:REPORT. It describes 
the equipment you need and explains how to start and leave the program. 
The chapter also explains how to choose commands from the pull-down 
menus, how to use the Edit and Help menus and the desk accessories, 
and how to use REPORT’s special keys. When you have finished reading 
the chapter, and have followed its instructions, you will be ready to begin 
using the REPORT program. 

What You Need to Use REPORT 
To take full advantage of all the features of the REPORT program, you 
need the following equipment: 

a a Macintosh computer 

an Apple Imagewriter printer, properly connected to your computer 

the program disk (A spare copy is also provided, in case the original 
disk is damaged. Store the spare copy in a safe place.) 

= your PFS files 

= (optional) an additional disk drive or a hard disk unit 

PFS:REPORT can display reports on the screen of your Macintosh, but it is 
really designed to produce printed reports. If you do not have an additional 
disk drive, you may find that there are some limitations on sorting 
information for your report. See the section, Sorting Reports with a Single 
Disk Drive, in Chapter 3 for a complete explanation of these limitations. 

Note: This manual assumes that you do not have an additional disk drive 
connected to your Macintosh. Where procedures differ for two-drive 
systems, they are discussed separately. 
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Starting PFS:REPORT 
You are now ready to begin using the program. The procedure for starting 
REPORT is slightly different depending on whether or not your Macintosh 
is already turned on: 

a If your Macintosh is turned on, exit whatever program you are using and 
eject the disk. Then insert the PFS program disk and double-click the 
icon when it appears on the desktop. (Alternatively, click the icon and 
choose the command Open from the File menu.) The Finder illustrated 
below appears on the screen. 

lf your Macintosh is turned off, first turn on the power. When the icon 
with the blinking question mark appears, insert the PFS program disk. 
Double-click the PFS disk icon now showing on your desktop, (or click 
the icon and choose the command Open from the File menu). The 
Finder appears on your screen: 

" @ File Edit View Special 

PS prog.) aSSaa_a_]__=__= 

4 items 331K in disk 71K available 
a 

PFS REPORT ST AFF 

Empty Folder System Folder 

9 
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To begin the program, double-click the PFS:REPORT icon. Next you see 
the PFS:REPORT title window asking you to choose a PFS data file or exit 
PFS:REPORT. 

" @ File Edit Functions 

PFS:REPORT 

Choose a PFS data file 

Exit PFS:REPORT 

© 1984 Software Publishing Corporation 
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Notice the oval buttons next to the options in the title window. Buttons 
appear on numerous REPORT windows. To make a selection using a 
button, position the pointer on it and click. 

If you choose a PFS data file, another window opens, listing the data files 
on your disk. If the file you want to use is on the program disk (the STAFF 
file, for example), click the file name and the Ok button (or simply double- 
click the file name). Otherwise, click the Eject button and insert your PFS 
file disk. A list of PFS files on the disk appears. 

Ll 

Note: The window can only display six files at a time, so if your file disk 
contains more than six files, click one of the scroll arrows or drag the 
scroll box until the file you wish to use appears. 
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Double-click the file name you want to use. The following window appears, 
showing the name of the file you have selected, and directing you to make 
a menu selection: 

" @ File £4 Functions Formats 

lease make a menu selection. 

While you are using REPORT, you will often see this window. REPORT 
displays it when you are starting up the program and returns to it after 
completing many of the commands on the menus. 

Ty 
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PFS:REPORT Menus 
At the top of your Macintosh desktop is a set of titles on the menu bar: 
File, Edit, Functions, Formats, (and sometimes, Help). These are the 
menus available to you when you are using REPORT. To see the 
commands on each menu, position the pointer on the menu title 
(Functions, for example) and drag it down. The Functions menu looks like 
this: 

" @ File ¢o IRIE 
_SSS_== Print a report 

Change headings 
Please make a| gases heading changes 
| Count forms 

To choose a menu command, drag the pointer down and release the 
mouse button on the line of your choice. Notice that most of the 
commands on the Functions menu appear in highlighted letters while the 
command Undo headings changes is dim. Highlighted commands are 
those you can perform at a particular stage of the program; dimmed 
commands are those you cannot choose at that time. 
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Using the Edit Menu with REPORT 

When you enter search information, change headings, or edit a report 

format with REPORT, you may find it convenient to use some of the Edit 

menu features. The PFS:REPORT Edit menu looks like this: 

tity Functions Formats 

Undo screen changes 

gey |r the report. Print report 

Copy 

Clear fields 

Show Clipboard 

Phone Ext: 

Job Title: 

Monthly Salary: 

eS ISIS OROI TD ssn in RA ESS See SOR SSO SOLIS OS 
1 ere ERT TIT 

You can cut one item of information at a time, store it temporarily in the 

Clipboard, and then paste it into another location. Or, you can copy the 

information you have cut. To see the contents of the Clipboard, choose the 

last menu command, Show Clipboard. 

If you review changes you have made to a page of a form and find them 

unacceptable, you can choose the command Undo screen changes to 

restore that page to its original state. 

Suggestions for using the Edit menu features appear in chapters where 

they may be helpful. You can learn more about the full set of Edit features 

from Macintosh, your owner’s guide. 
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Using the Help Menu 
When you are designing a report format, creating a predefined report 
format, and defining derived columns, the Help menu title appears on the 
menu bar. It contains all the column calculation commands that are 
available when creating report formats. To choose a column calculation 
command, click on the item you want to include as a column in your report 
and enter a column number. Then pull down the Help menu and choose 
the command you want. It appears automatically beside the number you 
just entered. (The commands for Page break and Keyword reports already 
include the number since they only function in column 1.) 

Special Keys Used by REPORT 
As you work with REPORT, you usually use the mouse to move the pointer 
and to perform other desired tasks. Sometimes, however, it may be more 
convenient to keep your fingers on the keyboard and perform specific 
actions from there. The keys you can use are described below: 

Key What It Does 

Confirms whatever entry you’ve made on a window so that 
REPORT moves on to the next step. In an alert box, 
pressing the Enter key is the same as clicking the heavily 
outlined button (for example, Ok). 

Moves the insertion point to the beginning of the next line. 
Using Return in an alert box is the same as clicking the 
heavily outlined button. 

Return | 

When filling in a form, Tab moves the insertion point 
forward to the next item. With the Shift key pressed, Tab 
moves the insertion point back to the previous item. On the 
print options window, pressing Tab moves the insertion 
point from box to box and highlights the text so that you 
can type over it if you wish. 

Moves the insertion point to the left one space and erases 
pag add the character in that location. 
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Used in combination with the following keys, Command is a 
shortcut to choosing a command from the Edit menu. 

X = Cut 
C = Copy 
V = Paste 

Used in combination with certain keys lets you enter 
accented and special characters. These are illustrated in 
Appendix A of your Macintosh owner’s guide. 

Using the Macintosh Desk Accessories 
with REPORT 
The full range of Macintosh desk accessories is available for you to use 
with REPORT. For example, you might want to decrease the speed at 
which your Macintosh interprets your double clicks to select icons or open 
files. Or, you might want to adjust the keyboard action to produce repeating 
characters with only a very light touch. With PFS:REPORT, you choose a 
desk accessory in the same manner you choose any menu command. Pull 
down the Apple menu at the far left of the menu bar, and choose any desk 
accessory command. 

Note: With REPORT, you may only use one desk accessory at a time. If 
you have a data disk in the drive when you choose a desk 
accessory, the disk is ejected, and you are asked to insert the PFS 
program disk. 

Choosing Another File 
When you want to stop using one PFS file and start working with another, 
pull down the File menu and choose the command Choose another file. | 
The dialog box listing the PFS data files on the disk appears. If the file you 
want to use is on the list, double-click the file name. Otherwise, click the 
Eject button and insert the disk containing the file you want. When the 
PFS files on that disk appear in the dialog box, double-click the file name 
of the file you wish to use. 

Note: Sometimes, when you choose the command Choose another file, 
REPORT automatically ejects your data disk and asks you to insert 
the program disk. Insert the program disk, click the Eject button 
when the dialog box appears, and insert the data disk containing the 
file you want to use. 

allele alates 
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Stopping Work 
When you want to stop using PFS:REPORT, you can either quit work 
altogether or move to another program. To quit work on your Macintosh 
altogether, pull down the File menu and choose Quit PFS:REPORT. Then 
Close all files, eject the disk, and turn the Macintosh off. 

WARNING: Never turn off your Macintosh unless you have quit 
PFS:REPORT. IF YOU DO, YOUR PFS DATA FILE MAY 
BE PERMANENTLY DAMAGED. 

You can stop using REPORT and start work on PFS:FILE or on another 
program. To do so, pull down the File menu and choose Quit 
PFS:REPORT. After a short pause, the Finder will display all the programs 
on the disk in the drive, and you can select another one to work on. 

If the program you want to use is not on the disk in the drive, you can click 
the close box or choose the Close All command from the File menu. 
Either action will close the files on the disk. After closing the files, choose 
the Eject command from the File menu and remove the disk from the 
drive. Then replace the disk with the one you want to use and begin work. 

Note: If you eject the disk without closing all files, the PFS:REPORT disk 
becomes an “alternate” disk, displayed as a shaded icon on the 
desktop. If the Macintosh needs the ejected disk later, it asks for it. 

In this chapter you have learned how to start and quit PFS:REPORT. You 
have also learned how to use some of the special Macintosh features and 
menus with the program. In the next chapter you will learn to use the 
program to choose forms for your report, and to decide how you want your 
report to be printed and formatted. | 
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This chapter explains how to use the Print a report command to prepare 
and print a report from a PFS:FILE data file. To print a report, you proceed 
through three windows. The first lets you choose which forms from the file 
you want to include on the report. The second lets you specify the settings 
for printing, such as where you want to print the report, the report title, 
page size, and so on. The third window lets you choose which items from 
the file will appear as columns in the report and the order in which they 
will appear. | 

A sample file named STAFF is stored on the REPORT program disk. You 
will use this file as you go through the chapter to produce a simple report 
with your own Macintosh. 

Choosing Print a Report 
Let's use the STAFF file to prepare a simple report listing names and 
addresses of all the people in the file. To begin, start the REPORT program 
according to the instructions in Chapter 2. 

Click the Open button to use an existing file. At the next window, select 
STAFF and click the Ok button. 



3-2 pfs:report 

REPORT then asks you to make a menu selection. Pull down the 
Functions menu and choose the command Print a report. A blank form 
from the STAFF file appears, with a message asking you to choose the 
forms you want in the report. The window looks like this: 

" € File Edit Functions Formats 

Page 1 -- please choose forms for the report. Print report 

. Employee *- Mh e 

'|Name: 

Address: 

: City: State: 

- Dept: Phone Ext: 

. Honthiy Salary: 

Choosing Forms 
The first step when preparing a report is to indicate which forms from the 
file you want to include in the report. You choose the forms by filling in 
search information next to the item names. 

If you want to include all the forms from the file, leave the window as it is 
and click the Print report button. 

If you want to include only certain forms from the file, enter search 
information exactly as you would for the Find forms function in PFS:FILE. 
The types of search information are summarized below. For a complete 
explanation of search information, refer to Chapter 5 of the PFS:FILE 
manual. 

If you enter PFS:REPORT finds 

abc abc only (uppercase or lowercase) 
XYZ any entry ending xyz 
abc.. any entry starting abc 

 ,.par.. any entry containing paqr 
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any nonblank entry 
?and any four-letter word ending with ‘and’ (band, land) 
<10 any number less than 10 
>99 any number greater than 99 
=33 the number 33 
=o any number between 1 and 5 
/=25 any number not equal to 25 
/A.. any entry not starting with ‘A’ 
i, any blank entry 

Note: The items you fill in with search information do not appear on the 
report unless you select them when entering the specifications for 
the format of your report (the third step in the process). 

When you have finished entering search information for the forms you want 
to include in your report, click the Print report button. 

Before you print your report, you may want to know how many forms in 
your file match the search information. The Count forms command uses 
search information to count the number of forms you have in a specified 
group, displaying the individual forms that match. Ud od 
For example, in the STAFF file, let’s count the number of people whose zip 
code starts with the number 9. Choose the command Count forms from 
the Functions menu. The window displays a blank form from the STAFF 
file. Click on the Zip item, and type 9.. as shown in the window below: 

” «@ File Edit Functions Formats 

Page 1 -- please choose forms to count. | Start counting : 

=| Employee e: 

State: 

Phone Ext: 

“Monthly Salary: 
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When you click the Start counting button, REPORT searches for the 
forms and tells you how many forms it counted. 

To continue preparing the name and address report, pull down the 
Functions menu and choose Print a report again. You won't need to enter 
any search information because you want to include all the employees in 
the STAFF file in the sample report. Click the Print report button and this 
window appears: 

” € File Edit Functions Formats 

Report Title 

Print to @ Printer CG Screen © Disk File 

L_] Pause between pages 

Lines per page Page width 

Choosing the Report Title and Print 
Options 
The second step when preparing a report is to give your report a title and 
to choose printing options. You can print the report to the screen, to a disk 
file, or to a printer. Indicate here the lines per page and page width. This 
window also lets you print the report according to a previously defined 
report format (See Chapter 6). 
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The window initially shows common settings, called default values, for the 
print options. To select the default values, simply give your report a title 
and click Ok. To change a print option, either click an alternate button or 
press the Tab key to move the insertion point to each box and highlight it 
so that you can enter a new value. The different options are described 
below: 

Report Title 

Enter the title you wish to assign to the report. Although the box on the 
print options window only displays about 48 characters, including spaces, 
your title can be as long as the width of your paper. If you continue 
entering a title once the box is full, each character you type will cause a 
character to disappear at the other end of the box. All the characters, 
however, will appear in the report title when the report is printed. 

Print to 

lf you want to print the report to a printer, leave the default setting of 
Printer. 

If you want to review the report on your screen, click Screen. 

lf you want to print the report to a disk file, click Disk File. Later, you can 
use a word processor to access the report and include it in a document. 

Pause between pages 
Click the button if you want the printer to pause at the end of each page of 
the report. This pause allows you to print the report on single sheet 
Stationery, such as your company letterhead. (This setting is ignored if you 
click Screen or Disk File.) 

Lines per page 

Enter the number of lines on each page of your printer paper, perforation 
to perforation. Position the perforation line exactly at the printer’s print 
head. REPORT automatically leaves a top and bottom margin. Standard 
8-1/2 x 11 fanfold printer paper has 66 lines per page, which is the default 
value. You can adjust this value to accommodate the size of your printer 
paper. The minimum number of lines you can enter for a report with page 
breaks and page numbers is 12. 
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To print the report without page breaks or page numbers, enter 0. This is 
particularly useful when printing a report to a disk file, to be included later 
in a word processing document. 

If you are printing to the screen, the maximum length of a page of a report 
is 23 lines. To display another page, click the Next page button. 

Page width 
Enter the width of your paper (between 6 and 255 characters). The default 
value is 80, the width of standard 8-1/2 x 11 fanfold paper. If you enter a 
width greater than 80 characters or if you want to print a wider than 
80-character report in condensed mode so that it fits on an 80-character 
page, you might have to send special characters to your printer to set it up. 

Note: The Apple Imagewriter’s maximum page width in ultracondensed 
mode is about 136 characters on standard fanfold paper. 

lf you are printing to the screen, the maximum width of the report that can 
be displayed is 68 characters. If the report is too wide, an alert box will 
appear on the screen. If you wish to review an item that you know is in the 
first few columns, click Ok and part of your report will appear. Otherwise, 
click Cancel and start over, revising the format of your report so that it will 
fit on the screen. 

Printer codes 

Enter any special codes you want to send to your printer. Consult the 
owner’s manual that comes with your printer to learn the complete range of 
your printer’s settings and the ASCII codes that control them. When 
REPORT starts printing, the ASCII numbers you enter are sent to the 
printer and cause it to print in the special mode for as long as the printer 
is on or until you enter another code. You can send up to 20 special codes. 
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For example, suppose you want to set the Imagewriter printer to print in 
ultracondensed mode (17 characters per inch), and in boldfaced mode. You 
would fill in the Printer codes box as shown below: 

Fr ke ie ie 
4q © File Edit Functions Formats 

Report Title 

Print to @ Printer © Screen ©) Disk File © 

L] Pause between pages 

Lines per page Page width 

Printer codes 

Special printing codes remain in effect until you exit REPORT and turn off 
your printer. If you wish to print another report using a different printing | 
mode, follow either of these procedures: | 

a Turn your printer off and on again. Then enter the codes you wish to 
send for your new report (or leave the box empty if the default setting is 
satisfactory). 

= Send the codes necessary to return to normal printing. (In the above’ 
example you would enter 27 34 to cancel the boldface mode and 27 78 
to return to 10 characters per inch.) 

When you have chosen the settings for your report, click Ok to continue. If 
you choose to print to a disk file, a dialog box will appear. Enter the name 
of the file where you want the report printed and then click Ok. 

Note: REPORT only temporarily stores any changes you make to the print 
options. The next time you start the program, the default values are 
again in effect. 
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For the STAFF example report, just type the title Employee Name and 
Address Report and click the Ok button without making any other 
changes to the window. The report format window appears next for you to 
choose the items you want to include as columns in the report: 

# * File Edit Functions Formats Help 

State: 

Phone Ext: 

Job Title: 

“Monthly Salary: 

Choosing and Organizing the Report 
Columns 
The last step before your report starts printing is to enter the specifications 
for your report format. This step determines which items appear as 
columns in the report, and in which order they appear. REPORT 
automatically uses the first line of the item as a column heading. 

Each report can have up to 20 columns. They are numbered from 1 to 20, 
starting with the left-hand column. To print an item as a column in the 
report, enter the desired column number next to the item name. 

REPORT sorts the report into alphabetical or numerical order based on the 
information in column 1. To sort the report according to a certain item, 
simply make that item column 1. If the information in column 1 is the same 
for more than one row, REPORT sorts those rows according to the 
information in column 2. 

If you have an additional disk drive, insert a blank disk in it for REPORT to 
use temporarily when sorting the forms for your report. 

1 a 
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If you do not need or do not want to sort your report, number your first 
column as column 3. If your report is long or complex, eliminating the sort 
in this way can save you some time. However, this does limit your report to 
18 columns (numbered 3 through 20). 

For example, to print the names in alphabetical order in the example 
report, number the items as shown on the following screen: 

3 @ File Edit Functions Formats Help 

Fill in page 1 of the report format. [ Print report | 

Employee =: : 

| Name: 1 

State: 4 

Phone Ext: 

| Monthly Salary: 

When you click the Print report button, REPORT begins preparing the 
report. First, it selects the forms that match the search information and 
sorts them (if you specified columns 1 and 2 in the report format window). 
While doing this, it displays the message “Preparing report - make a 
menu selection to stop.’ Then it prints the report, displaying the first page 
of each form as it prints information from that form in the report. When it 
finishes printing, it informs you how many forms were printed and asks you 
to make a menu selection. 
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lf you change your mind and do not wish to print the report, you can stop 
printing at any time. Simply choose another command to stop. Although 
REPORT stops printing, the printer will continue printing information from 
forms until it reaches the end of the form that was displayed on the screen 
at the moment you stopped the report. | 
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The printed name-and-address report looks like this: 

Employee Name and Address Report 

Address State 

Bennet, Liza 754 Granville Place Ridgewood Ca 

Calvin, Curt 254 Greentree Lane Woodville Ca 

Fawley, Susan 5634 Ridgewood Way Woodville Ca 

Peters, Marvin 3224 Valley View Road Ridgewood Ca 

Sanchez, Enrico 7831 Parkside Place Ridgewood Ca 

Thomson, John 869 Valley View Road Ridgewood 

Woodhouse, Emma 425 Oakview Way Ridgewood Ca 

Woolf, James 9732 Sunrise Place Ridgewood Ca 

Sorting Reports with a Single Disk 
Drive 
You can use REPORT with a single disk drive, but it may impose certain 
limitations on the report, depending on the amount of available space on 
the disk that contains your PFS file. If you are not sure whether the report 
can be sorted, simply try it. You should experience no problems if the 
available space on the disk is at least as large as your file. If there isn't 
enough room on the disk to sort the report, REPORT will display the 
message The disk is full. Try modifying the specifications for the report in 
one or more of the following ways, until you can produce a satisfactory 
report: 

= You can eliminate column 2, thus sorting on column 1 only. This allows 
you to continue using the subtotal, subaverage, subcount, keyword, and 
page break functions explained in Chapters 4 and 5, yet it saves space 
when sorting. 

You can enter different search information, so that fewer forms from the 

file are used in the report. 

You can eliminate both columns 1 and 2, so that sorting does not occur. 
This means you are limited to eighteen columns (numbered 3 through 
20). You can use the column total, average, and count functions, but not 
the subtotal, subaverage, keyword, or page break functions. 
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The other functions of REPORT, including derived columns, are always 
available. 

If you do not want to modify your report, you can copy the forms you need 
to another disk by using the commands Copy design only and Copy 
forms in PFS:FILE. 

In this chapter you have learned how to print simple reports. In the next 
chapter you will learn how REPORT uses various sorting methods, column 
calculations and different headings to produce more complex reports. Tou uw | 
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This chapter explains how to sort reports in various ways, how to perform 
calculations on the values in a column, and how to change the headings 
that are printed at the top of each column. The examples lead you through 
each of these tasks. 

Different Ways of Sorting Reports 
There are different ways to sort your reports depending on your needs. 
Alphabetic sorts put items in alphabetical order from A to Z. If you specify 
a numeric sort, then the items will be sorted in numerical order from the 
highest number to the lowest. The following sections describe the various 
ways of sorting in more detail. 7 

Alphabetic Sorts 

When you specify that a report have a column 1, a column 2, or both 
columns, REPORT automatically sorts it alphabetically according to the 
information in these columns. 
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For example, suppose you have a file that contains abstracts of recent 
publications. You could prepare a report that shows publisher, author, and 
title for each of the publications by using this report specification: 

4 @ File Edit Functions Formats Help 

Catalog 

ill in page 1 of the report format. Print report : 

ubl isher: iI 

ate of Publication: 

bstract: 

Since REPORT sorts the information in the report alphabetically according 
to columns 1 and 2, the publications report would look like this: 

A LIST OF BOOKS 

Publisher Author 

Edwards and Son, Inc. Page, John P. Writing Simple Software 

Peterson, Dorothy How to Mother a Corporaticn 

Rader, C.C. Technical Writing Made Simple 

Michon Publishing Butler, Ardith An Endangered Species 

White, Susan Dale Improving Data Entry Accuracy 

Newberg Review Press Baffaro, B.B. Independent Banking 
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Numeric Sorts 

If you want to sort a column of numbers, you specify that the items are to 
be treated numerically by putting a letter N next to column number 1 or 2 
on the report format window. REPORT then sorts the numbers into 
descending order. 

For example, if you wish to sort the employees in the STAFF file by salary, 
fill out the report format window as shown here: 

WWW WW F @ File Edit Functions Formats Help 

State: 

Phone Ext: 

| | 
onthiy Salary: iN 

ii 
pte This produces the following report: 

Staff Ranked Salary Report 

Job Title 

Thomson, John Administration Company President 

Calvin, Curt Manufacturing Process Engineer 

Sanchez, Enrico Manufacturing Design Engineer 

Woodhouse, Emma Administration Purchasing Manager 

Fawley, Susan Manufacturing Engineering Associate 

Bennet, Liza Administration Secretary 

Peters, Marvin Manufacturing Technician 

Woolf, James Administration Personnel Clerk 
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When printing numeric columns, REPORT observes the following rules: 

a it ignores all characters (including spaces) other than -, ., 0, 1, 2, 3, 4, 5, 
6, 7, 8, and 9. Be sure to use the number 1, not lower case |, and the 

zero, not the letter o. 

= a minus sign (—) before the first digit or after the last digit gives the 
number a negative value. | 

a if there are multiple decimal points, it ignores all but the first. 

= when printing, it inserts commas where necessary. 

a it adjusts all entries in a column to the highest number of decimal places 
found in that column. 

The following example shows you how you might fill in the same 
information on different forms in a file, and how REPORT would list the 

information from those same forms in a numeric column: 

File Item Numeric Column 

$1000 1,000.00 it ignores the $ and adds a comma 
: and two decimal places. 

112.5 112.50 it adds one decimal place. 

1.37 dollars 1.37 it ignores the word dollars. This item 
has the highest number of decimal 
places. All other entries are 
adjusted to it. 

2,000,137 2,000,137.00 it adds two decimal places. 

The numbers are not sorted in this example; however, if they appeared in 
column 1 or column 2, they would be sorted. 

Using Column Calculations 
REPORT can total, count, or average the numbers in a column. It can also 
give a subtotal, subcount, or subaverage, every time the item in column 1 
changes. You specify column calculations by entering the following 
commands (in uppercase or lowercase) beside the column number on the 

form: 

T Total. The program automatically treats this item numerically, adds 
all the numbers in the column, and prints the total at the end. 
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ST Subtotal. This produces a subtotal for each new item in column 1, 
and a grand total at the end of the report. 

A Average. The program automatically treats this column numerically 
and prints the average at the end. 

SA Subaverage. This produces a subaverage for each new item in 
column 1, and prints an average of all the numbers at the end. 

C Count. This counts the number of entries in a column, numeric or 

alphabetic. | 

SC Subcount This gives a subcount for each new item in column 1, 
and a complete count at the end. 

These commands are also available on the Help menu. Choose the 
command you want and it appears at the insertion point in the window. 

For example, to produce a report showing the average salary for all 
employees in the STAFF file, with subaverages by department, pull down — 
the Functions menu and choose Print a report. When the blank STAFF 
form appears, click Print report to include all the employees. Next, enter 
the report title: 

Average Salaries by Department 

and click Ok. (If the title box still displays Employee Name and Address 
Report, it is highlighted and disappears as soon as you begin typing.) 
When the next window appears, fill it out as shown here. The entry 4SA 
specifies that you want monthly salaries in column 4 with the average and 
Subaverages computed. 

" @ File Edit Functions Formats Help 

State: 

Phone Ext: 

onthiy Salary: 45A 
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Click Print report to produce the following report: 

Average Salaries by Department 

Job Title Monthly Salary 

Administration Bennet, Liza Secretary 

Thomson, John Company President 

Woodhouse, Emma Purchasing Manager 

Woolf, James Personnel Clerk 

Average: 

Manufacturing Calvin, Curt Process Engineer 

Fawley, Susan Engineering Associate 

Peters, Marvin Technician 

Sanchez, Enrico Design Engineer 

Average: 

Column Calculation Commands 

Let’s examine how these column calculation commands are used. Suppose 
Dept: 1C and Phone Ext: 3SC are specified in the STAFF file report format 
window as shown here: 

" @ File Edit Functions Formats Help 

Fill in page 1 of the report format. Print report : 

State: 

Phone Ext:35C| 

Job Title: 

onthiy Salary: 
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This produces the following report: 

Department Phone Count 

Phone Ext 

Administration Bennet, Liza 

Thomson, John 

Woodhouse, Emma 

Woolf, James 

Count: 

Manufacturing Calvin, Curt 

Fawley, Susan 

Peters, Marvin 

Sanchez, Enrico 

Count: 

The use of Count and Subcount shows you that there are two departments 
with four phones each, and a total of eight phones. Notice that REPORT 
only prints the department names once although there are four phones 
listed in each department. This is because REPORT will not print the same 

_information repeatedly in column 1 if it is the same for more than one row. 
_ If you want REPORT to repeat the same information on another row, (for 
example, you might want to create a phone list that includes several people 
with the same last name), eliminate column 1 and sort on column 2. 

When you use T, ST, A, or SA, REPORT automatically assumes that the 
information in the column is numeric. As a result, any non-numeric 
characters are ignored, the decimal points are lined up, trailing zeros are 
added to make each entry the same length, and the numbers are right 
justified. 
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When you use C and SC, however, you must also enter N if you want the 
column treated numerically, since C and SC can be used with non-numeric 
information. For example, compare these two specifications: 

Price: 3C Price: 3CN 

and then compare their results: 

4 DOLLARS 
3.99 

Count: 

You can have REPORT perform more than one calculation in the same 
column; for instance, you can have it total, average, and count the same 
column. If you use more than one of the column calculations, the average 
appears first, the total next, and the count last. You can enter the 
commands themselves in any order. For example, entering either 4 ST C or 
C ST 4 would produce the same result. 

Using Zeros and Blanks 
When you plan to use the calculation commands, think carefully about the 
difference between a 0 (zero) and a blank in your file. If you are calculating 
average test scores, for example, the difference between a score of zero 
and no score is very significant. It is especially important when using 
average or count. An item that contains no information is not included in 
the calculation, but an item that contains a zero is included. For example: 

The average of 4 and 2 is ae ge 3 
2 

but the average of 4, 2, and 0 is 
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Starting a New Page 
Suppose you want the Average Salaries by Department report to start on a 
new page whenever the department changes. You can do so by entering a 
P (for page break) next to the column number. (P will only work in column 
1.) The following report format window, differing only in adding the P, 
produces the same report, but with a separate page for each department. 

\ 

" @ File Edit Functions Formats Help 

: Name: 2 

: Address: 

| City: State: 

Dept: 1P Phone Ext: 

a Honthly Salary: 4SA 

Changing the Column Headings 
Normally, REPORT uses the first line of the item name as a column 
heading. It determines column widths for the report by the number of 
characters in the heading or by the widest entry in the column (whichever 
is greater). You may want to substitute a more appropriate column heading, 
or shorten the column headings in order to fit more columns across the 
page. 
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Choosing the Change Headings 
Command _ 
Let’s use Change headings to change a column heading for the STAFF 
file. Pull down the Functions menu and choose Change headings. The 
window displays the form design from the STAFF file: 

r = z : 
@ File Edit Functions Formats 

State: 

Phone Ext: 

| Honthly Salary: 

Setting New Headings 
You enter a new heading for an item by typing the heading on the form in 
the same way you type information when adding information to the file. 
Usually you will want to shorten a heading to fit more columns in your 
report. 
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For example, the entries in the Monthly Salary item on the STAFF form are 
typically only five or six characters long, but the item name is 14 
characters. Thus, when that item is used as a column in a printed report, it 
is more than twice as wide as it needs to be. Let’s change the heading to 
Salary, so that the column is only six characters wide. Click on the 
Monthly Salary item, and type Salary as shown in the window below: 

” @ File Edit Functions Formats 

Page 1 -- change the column headings. 

Employee #:- 

State: 

Phone Ext: 

Job Title: 

Honthliy Salary:Salary 

mm The new heading is automatically stored in the STAFF file when you 
proceed to another function. From now on, when you print a report that 
lists information from the Monthly Salary item, the column heading 
appears in its shortened form. The monthly salary report below shows the 
new column heading: 

P) 

Monthly Salaries Report 

Job Title 

Administration Bennet, Liza Secretary 

Thomson, John Company President 

Woodhouse, Emma Purchasing Manager 

Woolf, James Personnel Clerk 

Manufacturing Calvin, Curt Process Engineer 

Fawley, Susan Engineering Associate 

Peters, Marvin Technician 

Sanchez, Enrico Design Engineer 



4-12 pfs:report 

Editing Heading Changes 
If you want to go back to the original item name as a column heading, or if 
you want to compress your column headings still further, you can modify 
the new headings. To modify headings that you have already entered, 
choose the command Change headings again. The window shows column 
headings previously stored for this file. 

You can change a heading by double-clicking on the item you want to 
change, to highlight it. As soon as you begin typing in the new heading, 
the highlighted text disappears. 

You can delete all the column headings stored in a file and return to the 
item names as they are on the form by pulling down the Functions menu 
and selecting Undo heading changes. An alert box appears, warning that 
REPORT is about to remove the new headings: 

” € File Edit Functions Formats 

id Undo heading changes? 

If you want to remove the headings, click Ok and REPORT removes the 
headings from the file. REPORT returns you to where you were before you 
chose Undo heading changes unless you were at the change headings 
window (in which case it will ask you to make a menu selection). 

If you change your mind and decide not to remove the headings, click 
Cancel. REPORT returns you to where you were before you chose Undo 
heading changes. 
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This chapter has been about creating more complex reports by sorting in 
different ways, using column calculations and changing headings. The next 
chapter tells you how to produce two kinds of special reports, one with 
columns derived from information in other columns, and the other with 
information identified by subject keywords. 
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Bn  ——_— — —_ I ,L,_—<xxExExEXEX—x—xxxx<<xxx____ CCC 

REPORT provides two special types of reports that are very useful. The 
derived columns capability enables you to produce columns in your report 
that are computed from the information in other columns, rather than taken 
directly from your data file. You can also produce reports from files 
containing a lot of text, using subject keywords to identify information that 
is important for your report. 

Reports Using Derived Columns 
A derived column is calculated from information in other columns of a 
report, including other derived columns. It does not correspond to an item 
name in a file, as do other report columns. You can have up to three 
derived columns in a report. 

For example, suppose you want to calculate a 17% bonus for each 
employee in the STAFF file. You can prepare a report in which REPORT 
calculates 17% of the monthly salary of each employee from a Monthly 
Salary column and puts this amount in a new column called Bonus. Then, 
REPORT can add the amount of the bonus to the monthly salary and place 
this amount in another derived column called Total Pay. 
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You fill in the derived columns while you are designing your report format. 
First, you decide on the columns you want in your report, and then choose 
the command Define derived columns from the Formats menu. The 
derived columns window looks like this: 

" @ File Edit Functions Formats Help 

/ Define derived columns for the report format. | Ok | : 

S Coluan Heading: 
#4Coluan Formula: 
2/Coluan Format: 

S Column Heading: 
#1Coluan Foreaula: 
2{Coluen Format: 

S Coluan Heading: 
“1Coluan Forsula: 
2iColuan Format: 

Filling in the Derived Columns Window 

Since you can have a maximum of three derived columns in one report, 
there are three identical groups of options on the derived columns window. 
You fill in one of these groups for each derived column on a report. The 
options are: 

Column Heading: Enter the heading you want printed in the derived 
column. If you leave this option blank, the formula 
of the column is used as a heading. 

Column Formula: Enter the formula for your derived column. Columns 
in the formula are identified with a # preceding the 
column number. 

Column Format: Enter the column number for your derived column 
and any column calculations you want. For 
example, entering a 7T tells REPORT to print this 
column in column 7 and total it. You can even put 
the derived column in column 1, which means that 
the program sorts on the results of the derived 
column calculation. 
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Creating the Derived Column Formula 
You tell REPORT what calculations to perform for a derived column by 
developing a formula using these rules: 

1. Columns in the formula are identified by # followed by the column 
number. For example, #1 — #5 means the value in column 1 minus the 
value in column 5. 

. Use a combination of the following mathematical operators and numbers 
to tell REPORT what calculations to perform: 

+ add 
— Subtract 
* Multiply 
/ Divide 
() Perform this calculation first. Parentheses can only be nested two 

deep. 

. REPORT evaluates the formula from left to right, evaluating the 
expressions in parentheses first. For example: 

#3 + 4 * #1 means add 4 to column 3 and multiply the result 
by column 1. 

#3 + (4 * #1) means multiply column 1 by 4 and add the result 
to column 3. 

. Since REPORT works from left to right across the report, a formula must 
not use the values of any derived columns that are printed to its right. 
For example, if columns 1 and 4 of a report are derived columns, 
column 1 is calculated before column 4. If column 1 tries to use the 
derived value in column 4 in its calculation, there will not yet be a value 
in that column to use. 

. A formula can include a reference to itself. For example, a formula used 
in column 7 is #3 + #7. In such a case, the value used for #7 is that 
from column 7 of the previous row. This calculation produces, in column 
7, a running total of whatever is in column 3 (its value for the first row is 
the value in column 3). 

When you have entered the derived columns information, click Ok to return 
to the report format window. You can make revisions to your format if you 
wish or have REPORT prepare and print your report. 

Note that REPORT always rounds derived columns to two decimal places 
before printing. Also, when REPORT produces a report containing derived 
columns, its performance may be somewhat slower. 

a 
Eee 
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Let’s prepare the employee bonus report mentioned earlier. If you are 
already working with the STAFF file, pull down the Functions menu and 
choose Print a report. Since everyone gets a bonus, leave the choose 

forms window blank and click the Print report button. Next, type in the title 
Employee Bonus Report and leave the default settings for the other items 
as they are. The window should look like this: 

" € File Edit Functions Formats 

Report Title 

Employee Bonus Report re) 

Print to @ Printer Screen © Disk File 

[] Pause between pages 

Lines per page Page width 

Click Ok, and the report format window appears. Enter a 1 in the Name 
item to make it the first column of the report and a 2 in the Monthly 
Salary item to make it the second column. The window should look like 
this: 

" € File Edit Functions Formats Help 

ill in page 1 of the report format. Print report |} 

State: 

—— 
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Monthly Salary: 2 
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Now you are going to define the derived columns. Pull down the Formats 
menu to choose the command Define derived columns. Fill in the derived 
columns form as follows: 

© File Edit Functions Formats Help 

Heading: Bonus 
Formula: #2 * 0,17 
Format: 3 

Heading: Total Pay 
Formula: #2 + #3 

Format: 4T 

Heading: 
Foraula: 

Forrgat:- 

This form defines a column 3 with the heading Bonus and with a 
calculated value that is 17% of the amount in column 2. The second ~ 
derived column, column 4, has the heading Total Pay and adds the salary 
amount in column 2 to the calculated bonus amount in column 3. 

Click Ok and REPORT returns to the report format window. Click the Print 
report button to print your report. It should look like this: 

Employee Bonus Report 

Bonus | Total Pay 

Bennet, Liza 

Calvin, Curt 

Fawley, Susan 

Peters, Marvin 

Sanchez, Enrico 

Thomson, John 

Woodhouse, Emma 

Woolf, James 

Total: 23,926.50 
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Reports Using Keywords 
When you store text information in your files, you may want to identify such 
information by means of subject keywords. You might identify the same 
form by several different keywords, if it is of interest for several different 
reasons. When you print a report using these keywords, the information 
from each form is printed once for each identified keyword. 

Processing a keyword report can be a fairly time-consuming task, 
depending on the complexity of your form and the number of keywords 
entered for each form. 

Suppose you keep a file of technical information from the magazines you 
read and use an item named Keyword for your keywords. The Keyword 
item includes all the subjects for which the article is of interest. The 
Abstract item gives a brief description of the article. By using the following 
report format, you specify columns 1, 2, and 3 and identify column 1 as a 
keyword sort (by clicking on the Keyword item and choosing the command 
1K from the Help menu). 

f @ File Edit Functions Formats Help 

agazine: 2 

eysvord: ik 

bstract: 3 
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The result is a report alphabetically sorted for every different keyword 
entered in your file. It looks like this: 

KEYWORD SORT OF ABSTRACTS 

Keywords Magazine Abstract 

Data News This article describes the use of a new ECL 

process to fabricate 16K RAMs for less than $4 each. 

Failure Elec Times An unsuspected cause of RAM failure has 

been traced. People have found that gamma radiation 

causes random temporary bit faults. MOO" O) OOO 

Weekly News A problem is discussed which causes premature 

failure of memories due to warpage of the PC boards, 

especially at high temperatures. 

OOO. © 
Data News This article describes the use of a new ECL 

process to fabricate 16K RAMs for less than $4 each. 

Weekly News A problem is discussed which causes premature 

failure of memories due to warpage of the PC boards, 

especially at high temperatures. 

PCboards Weekly News A problem is discussed which causes premature 

failure of memories due to warpage of the PC boards, 

especially at high temperatures. 

Data News This article describes the use of a new ECL 

process to fabricate 16K RAMs for less than $4 each. 

Elec Times An unsuspected cause of RAM failure has 

been traced. People have found that gamma radiation 

causes random temporary bit faults. 

As you can see, REPORT prints each abstract once for each keyword 
entered on the form. If you make the Keyword item column 1 but omit the 

— K command, you get this report from the same information: 

== 

A NORMAL REPORT 

Keywords Magazine Abstract 

ECL Memory RAMS Data News This article describes the use of a new ECL 

process to fabricate 16K RAMs for less than $4 each. 

Failure Memory PCboards Weekly News A problem is discussed which causes premature 

failure of memories due to warpage of the PC boards, 

especially at high temperatures. 

Failure RAMs Elec Times An unsuspected cause of RAM failure has 

been traced. People have found that gamma radiation 

causes random temporary bit faults. 
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To identify text using subject keywords, create an item on your file form to 
contain your keywords. When you enter more than one keyword into the 
item, separate them from each other with a space (Smith Jones Brown). If 
you have a keyword that is really more than one word, either use an 
underscore between the words (Personal__Computers) or do not space 
between them (PersonalComputers). 

In this chapter you have learned to produce special reports using derived 
columns and keywords. In the next chapter you will learn how to save 
report designs that are more complicated or that you use repeatedly. 
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REPORT allows you to design report formats and save them for repeated 
use. Any report you design can be saved. For example, if you design a 
complex report, or one using derived columns, you will probably want to 
save this report design. 

You can save up to eight different report formats for each PFS file and use 
them to print periodic reports in the same format. Once you have created 
eight formats, the command Create a report format is no longer available, 
and you will have to remove a format if you want to create a new design. 

You give each format a name up to ten characters long, and REPORT 
stores the format in the file. When you want to use one of these formats, 
you select the report format you wish to use at the same time as you give 

- your report a title and decide upon the settings for your printer. REPORT 
then produces the report without your having to fill in the report format 
window. 

This command is also useful for experimenting with a variety of report 
formats before you decide on those you want to use. Since REPORT saves 
the report formats in the file, you can try out several different ones, using 
different names, until you find one that you like. Then simply remove the 
unwanted formats. 

Creating a New Report Format 
To create a report format, select the PFS data file you wish to use for your 
report, pull down the Formats menu and choose the command Create a 
report format. Then give your report format a name. When the blank form 
from your file appears, enter the same type of format specifications for your 
report as you did in the previous chapters. When you have finished, 
choose another command from one of the menus and REPORT saves your 
report format in the file you selected. You can now print the report or 
perform another activity. 
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Let’s store a report format for the STAFF file. First pull down the Formats 
menu and choose the command Create a report format. A dialog box 
appears asking you for the name of the report format you want to create. 
Your screen looks like this: 

" « File Edit Functions Formats 

Please make a menu selection. 

New format name 

ata ala 

The report format we will create in this example shows total salaries by 
department, so let’s name it Salaries. Type Salaries in the New format 
name box. 

Click the Ok button and the report format window for “Salaries” appears: 

. @ File Edit Functions Formats Help : 

Eaployee #: | 

Nase: 

Address: 

City: State: 

Dept: Phone Ext: 

Job Title: 

Honthiy Salary: 

—— 
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You fill in this form the same way you fill in any report format. To produce 

the Salaries report, enter a 2 in the Name item, a 1 in the Dept item, and 

a 3T in the Monthly Salary item. The window should look like this: 

g «& File Edit Functions Formats Help 

Edit page 1 of the report format “Salaries”. 

[Employee *: oy 

q 

State: 

Phone Ext: 

“Monthly Salary: 31| 

Notice that the Help menu is available to make entering the report format 

easier. 

When you have finished, make a menu selection (for example, choose 

Print a report). REPORT saves the report format named Salaries in the 

STAFF file. You can now print the report or perform another activity in 

PFS:REPORT. 

Printing With a Predefined Report 

Format 
Once you have stored a report format in a file, you can use this format 

repeatedly to print reports from that file. To print a report, pull down the 

Functions menu and choose the command Print a report. Choose the 

forms you wish to include in the report and click the Print report button. 

When the next window appears, type in a title for the report and click the 

button next to the report format you wish to use. Then click Ok when you 

have decided on the settings for your printer. REPORT skips the report 

format window and immediately prints the report. 
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Let’s print a report using the format you just stored in the STAFF file. Pull 
down the Functions menu and choose Print a report. Since you want to 
include all the forms from the file in your report, leave the choose forms 
window blank and click the Print report button. Fill in the print options 
window as follows, making sure that you click the Salaries button: 

” @ File Edit Functions Formats 

Report Title 

SALARIES REPORT, MARCH 

Print to @ Printer © Screen © Disk File 

[] Pause between pages 

Lines per page Page width 

© Don't use predefined report format 

@ Salaries 

Click Ok, and the program uses the report format from your STAFF file to 
prepare the report. The report looks like this when printed: 

SALARIES REPORT, MARCH 

Administration Bennet, Liza 

Thomson, John 

Woodhouse, Emma 

Woolf, James 

) 
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Manufacturing Calvin, Curt 

Fawley, Susan 

Peters, Marvin 

Sanchez, Enrico 

Pry 
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Modifying a Predefined Report Format 
To change a predefined report format, choose the command Edit “report 
format name” from the Formats menu. When the format appears, you can 
change it by double-clicking on a single item (to select it), and then typing 
in a new entry, or you can choose Clear fields from the Edit menu to 
erase all the specifications on a displayed page and start over. If your 
predefined report format contains a derived column formula, you may want 
to modify that, too. Choose Define derived columns from the Formats 
menu and use the same techniques to edit the derived columns. 

Suppose you want to revise the Salaries report format to have it include 
the Job Title item and to have it subtotal the salaries by department. To do 
so, pull down the Formats menu, choose the command Edit ‘‘Salaries’’ 
and your report format “Salaries” appears. Click on the Job Title item and 
type 3 to put this item in column three of the report. Double-click on 
Monthly Salary to highlight the entry. Then type 4ST to indicate that you 
now want this item to be column four, with subtotals by department. 

| 
When you have made the changes, the window should look like this: | 

os RS Be De I I Se L|  tie aee eet Sn 

dit page 1 of the report format "Salaries". 

| 

State: 

Phone Ext: 

nthiy Salary: 4ST| 
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Pull down a menu and choose another activity. REPORT stores the revised 

format in the STAFF file and you can now print the report or perform 

another activity. 

Removing a Predefined Report Format 

If you want to remove the Salaries report format, pull down the Formats 

menu. Notice that the command Remove this report format is dimmed 

and is therefore not available. To highlight it, first choose the command 

Edit ‘Salaries’. When the report format appears, pull down the Formats 

menu again. The command Remove this report format is now available. 

Choose it to remove the format currently displayed. The following warning 

appears, giving you a chance to change your mind: 

"  € File Edit Functions Formats Help 

/ Edit page 1 of the report format "Salaries". : 
ey 

- Employee ®: 

¥2) Remove this report format? 

lf you want to remove the report format, click Ok. REPORT removes it and 

asks you to make a menu selection. The next time you look at the Formats 

menu, you see that the command Edit ‘‘Salaries’” has been removed. The 

format name is also removed from the print options window. : 

a 

—_ 

ee 

a 
—= 

i 

a 

a 

a 

— 

' r—s 

-—s 

If you want to keep the format after all, click Cancel to redisplay the 

predefined report format. nv) 
This chapter has told you how to save report formats in your PFS files. 

Return to any of the preceding chapters when you need suggestions on 

creating different types of reports. Turn to the Quick Guide to PFS:REPORT 

for quick reminders on using the program. 
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REPORT displays a message whenever it encounters an error condition. 
Certain errors are the result of mistakes made when you enter information 
(such as filling in search information, the print options, or the report format 
specifications). Other errors are the result of physical limitations or 
problems with certain components of your Macintosh. Error messages are 
displayed like this: 

” € File Edit Functions Formats 

ti 7 STAFF 
_ Fill in page 1 of the report format. Print report] 

. Eaployee #: 

ip The format used did not produce a report. 

In most Cases, error messages are displayed in alert boxes with buttons 
you click to indicate your choice of action. For further explanation of 
causes of errors and suggested solutions, refer to the alphabetical list 
below. 

Message Corrective Action 

Can’t print to your PFS You tried to print to a disk file using the same 
data file name as the PFS file you are currently using. 

REPORT does not allow you to replace your 
current data file with a disk file. Enter a 
different name for the disk file. 
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Message 

Clipboard contents are 
too big to fit in memory 

Correct error in formula 

Insert a blank disk for 
sorting 

lO error 

Remove this report 
format? 

Corrective Action 

REPORT cannot be loaded into memory 
because the contents of the Clipboard are too 
big. If you click Ok, REPORT continues 
loading into memory but erases the contents 
of the Clipboard. If you click Cancel, you 
return to the Finder. Use another application to 
edit the contents of the Clipboard before 
loading REPORT. 

The formula for a derived column is incorrect 
due to an unrecognizable or out-of-sequence 
character, or parentheses nested more than 
two deep. The insertion point is in back of the 
first character causing the trouble. Retype the 
formula to correct it and try again. 

This message only appears if you have more 
than one drive. REPORT needs temporary 
work space to sort a report. If there isn’t 
sufficient space on the disk in your drive, 
REPORT prompts you with this message. 
Insert a blank disk in the empty drive and 
Click Ok. (If you don’t insert a blank disk in 
your other drive and you click Ok, REPORT 
will try to sort anyway.) 

It is unlikely that you will see the IO error 
message. If you do, it is the result of a system 
problem involving either your Macintosh or 
your disk or both. Begin using your most 
recent backup disk immediately. Check the 
section If Something Goes Wrong in 
Macintosh, your owner’s guide, for solutions to 
problems with the Macintosh. If |O error 
persists, see your Apple dealer. 

This message gives you a chance to change 
your mind when you tell REPORT to remove a 
predefined report format from a file. Click Ok 
to proceed or Cancel to stop the process. 

a 
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Message 

The data file is at 
maximum size 

The disk is full 

messages A-3 

Corrective Action 

REPORT is unable to continue working on a 
file that has reached the maximum size of 4 
megabytes. If the file size is too big, use the 
Copy design only command in FILE to copy 
the design to a new file and then choose 
Copy forms to add the forms you want to 
include in your report. 

EITHER 

REPORT attempted to write some information 
(such as new headings or a predefined report) 
in your PFS file, and found there was no room 
on the disk. If you have some unnecessary 
forms or predefined report formats in the file, 
make space by removing them (see Chapter 9 
in your FILE manual for information on 
removing forms). If the disk has an unneeded 
file on it, you could remove it, or copy it to 
another disk. 

OR 

REPORT is trying to sort a report and has run 
out of space. Try modifying the report 
specifications in the following ways: 

= If you have two drives, place a blank disk in 
the other drive. 

You can eliminate column 2 and sort on 
column 1 only. This lets you continue using 
subtotal, subaverage, subcount, keyword, 
and page break, yet saves space when 
sorting. 

You can enter different search information, 

so that fewer forms from the file are used 
for the report. 

You can eliminate both columns 1 and 2, so 
that sorting is not performed. 
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Message 

The format used did not 

produce a report 

The report is too wide 
for the page. Print 
anyway? 

Corrective Action 

If you don’t want to modify your report, you 
can always use the Copy design only 
command in PFS:FILE to make a copy of your 
file design on another disk. Then choose 
Copy forms to move the forms you wish to | 
use in your report. Check the Finder on the 
other disk first, to make sure that the space 
available is at least twice the size of the file 
you are about to create. (REPORT usually 
needs at least as much space as the file you 
want it to sort.) 

REPORT couldn't produce a report because 
there were no column numbers in the report 
format. Choose Print a report again and 
reenter your search information. If you used a 
predefined report format, choose Edit “report 
format name” from the Formats menu and 
check that it contains column numbers. 
Otherwise, enter column numbers when you 
reach the report format window. 

The report you specified will not fit in the page 
width. A frequent cause of this is that the item 
names are very long, which forces the 
columns to be correspondingly wide. To 
shorten column headings, use the Change 
headings command (see Chapter 4). 

To change the Page width, choose Print a 
report and enter the search information again. 
When the print options window appears, 
specify a wider page. 

To print out as much of the report as will fit, 
click Ok. 

pA A 



Message 

Unable to create a work 

file 

Undo heading changes? 

Use fewer characters to 
choose forms 

(in the report) 

messages A-5 

Corrective Action 

REPORT cannot create a work file to use as 
temporary storage when sorting forms for 
printing. This is either because there is very 
little free space on the disk or because the 
disk is damaged. Check the Finder to see how 
much space there is on the disk. Remove or 
copy files to another disk to create space 
equal to the size of the file you are using. 

If this message appears again when you try to 
sort forms for a report, your disk is probably 
damaged. Use the Finder to copy your files to 
a blank disk. 

To prevent removal of your headings 
accidentally, this message appears when you 
choose the command Undo heading 
changes. Click Ok to return to the item names 
as they are on the form or Cancel to keep 
them in the file. 

The search information you entered will not fit 
in REPORT’s internal storage area. Specify 
search information with fewer characters. 

REPORT was unable to calculate the numeric 
value of this item for one of the following 
reasons: 

a The value to be printed exceeded 20 digits 
either in its original form in the file or 
during processing. Use smaller numbers. 

The value could also exceed 20 digits due 
to an error in a derived column 
specification. Check the formula, and 
correct it if necessary. 
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Message Corrective Action 

= Another possible cause is that one form in 
the file has an exceptionally large number 
of trailing decimal places which causes all 
values to be given that number of places 
and possibly to exceed 20 digits. Reduce 
the number of decimal places in the 
exceptional item in the file. 

A derived column formula referred to a 
value in a derived column to the right in the 
same row. Since the columns are evaluated 
from left to right for each row, the value is 
not yet known. Rearrange the derived 
columns so that they can be calculated 
from left to right. 

An attempt was made to divide by zero in a 
formula. Correct the data or change the 
formula. 
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example file B-1 

This manual uses a series of examples based on a PFS:FILE data file 
named STAFF. When you receive your PFS:REPORT package, you will find 
this file stored on the REPORT program disk. If for any reason you need to 
recreate the STAFF file, you can do so by following the instructions below: 

To create the STAFF file, start PFS:FILE. Click Create a new file, type 
STAFF in the New file name box and click the Ok button. When the form 
design window appears, type in the following design: 

” «File Edit Functions Formats 

Fill in page 1 of the design. ? | : 

States 

Phone Exts 

[Monthly Salary;| 
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When you have completed the form design, pull down the Functions menu 
and choose Add forms. When the new form window appears, enter 
information for the eight employees listed below. Enter the information 
exactly as it is shown, even though some of the items are inconsistent. The 
examples in this manual can then show how REPORT deals with these 
inconsistencies. 

Employee #: M8877 Hired: 74/11/05 
~ Name: Calvin, Curt 
Address: 254 Greentree Lane | 
City: Woodville State: CA Zip: 93137 

Dept: Manufacturing Phone Ext: 188 
Job Title: Process Engineer 
Monthly Salary: $3600 

Employee #: M3245 Hired: 78/06/22 
Name: Sanchez, Enrico 
Address: 7831 Parkside Place 
City: Ridgewood State: CA Zip: 93132 

Dept: Manufacturing Phone Ext: 189 
Job Title: Design Engineer 
Monthly Salary: $3,250 

Employee #: A3476 ~ Hired: 80/10/15 
‘Name: Thomson, John 
Address: 869 Valley View Road 
City: Ridgewood State: Ca Zip: 93132 

Dept: Administration Phone Ext: 155 
Job Title: Company President 
Monthly Salary: $5,000 

pe 
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Employee #: A0765 Hired: 76/09/21 
Name: Bennet, Liza 
Address: 754 Granville Place 
City: Ridgewood State: Ca Zip: 93132 

Dept: Administration Phone Ext: 119 
Job Title: Secretary 
Monthly Salary: 1,200 

Employee #: M0934 Hired: 77/09/30 
Name: Fawley, Susan 
Address: 5634 Ridgewood Way 
City: Woodville State: CA Zip: 93137 

Dept: Manufacturing Phone Ext: 195 
Job Title: Engineering Associate 
Monthly Salary: 2100 

Employee #: M5524 Hired: 81/04/27 
Name: Peters, Marvin 
Address: 3224 Valley View Road 
City: Ridgewood State: CA Zip: 93132 

Dept: Manufacturing Phone Ext: 167 
Job Title: Technician 
Monthly Salary: $1100 

Employee #: A1265 Hired: 76/04/23 — 
Name: Woodhouse, Emma 
Address: 425 Oakview Way 
City: Ridgewood State: CA Zip: 93132 

Dept: Administration Phone Ext: 179 
Job Title: Purchasing Manager 
Monthly Salary: $3,200 

example file B-3 
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Employee #: A0139 Hired: 72/09/16 
Name: Woolf, James | 
Address: 9732 Sunrise Place 
City: Ridgewood State: CA Zip: 93132 

Dept: Administration Phone Ext: 143 
Job Title: Personnel Clerk 
Monthly Salary: 1,000 
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quick quide QG-1 

a quick guide to 

Enter 

Return 

Tab 

Backspace | 

Confirms whatever entry you’ve made on a window so that 
REPORT moves on to the next step. In an alert box, it is 
the same as clicking the heavily outlined button (for 
example, Cancel). 

Moves the insertion point to the beginning of the next line. 
In an alert box, it is the same as clicking the heavily 
Outlined button (for example, Cancel). 

Moves the insertion point to the next item on the form. With 
the Shift key pressed, Tab moves the insertion point back 
to the previous item on the form. On the print options 
window, pressing Tab moves the insertion point from box to 
box and highlights text so that you can type over it if you 
wish. 

Moves the insertion point to the left one space and erases 
the character in that location. 

Lets you enter accented and special characters. Refer to 
Appendix A of your Macintosh owner’s guide. 

Used in combination with the following keys: 

Cuts highlighted text and places it on the Clipboard. 

Copies highlighted text and places it on the Clipboard. 

Pastes text from the Clipboard at the insertion point on your 
screen. 
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Printing a Report 

Steps 

Search | 
Information 

. Insert the PFS file and open it. 

. Pull down the Functions menu and choose Print a 
report. 

. Fill in search information if necessary. Use Count 
forms, if desired, to find out how many forms 
match your search information. 

4. Choose the print options. 

. Fill out the report format window. To include a 
derived column, choose Define derived columns 

from the Formats menu. 

. Click the Print report button to prepare and print 

the report. 

leave window blank to print all forms 
abc finds abc only (upper or lower case) 
xyz finds any entry ending xyz 
abc.. finds any entry starting abc 
..paqr finds any entry containing par 
bi finds all nonblank letters 
?and finds any four letter word ending with and 

(band, land, etc.) 
<10 finds any number less than 10 
>99 finds any number greater than 99 
=33 finds the number 33 
=1..5 finds any number between 1 and 5 
/=25 finds any number not equal to 25 
/A.. finds any entry not starting with A (or a) 
l.. finds all blank entries 
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Print Type the title you want in the Report Title box. 
Choose your report destination (click either Printer, 

Options Screen or Disk File). aa 

lf you are using single sheet paper, click the Pause 

between pages. 
Enter the lines per page (66 for a standard 11-inch 

page, for most printers). Enter a O for a report with 

no page breaks or page numbers. 

Choose the page width (80 for an 8 1/2 by 11 inch 
page when printing in regular print mode; 136 to 
print in ultracondensed mode on the same size 

page). 
Enter special codes to set up your printer. Refer to 

the owner’s manual that comes with your printer to 

learn the complete range of settings available and 

the codes that control them. You may enter up to 

20 special codes. 
If you are using a predefined report format, click 

the button beside its name. 

a 

Report n make this column n (maximum 20 - sorts on 

ae columns 1 and 2) 

Specifications = nl totals all numbers in column n. 
subtotals column n whenever the item in 
column 1 changes. | 

nA averages all numbers in column n. 

subaverages column n whenever the item in 

column 1 changes. 
nC counts all items in column n. 

subcounts column n whenever the item in 

column 1 changes. 

nN treats the column numerically, lining up 

decimal points and ignoring non-numeric 

characters. ae 
1K sorts column 1 by keyword, with every form 

printed once for each keyword entry (column 1 

only). 
begins a new page whenever the item in 
column 1 changes (column 1 only). 
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Derived ‘a Choose Define derived columns from the Formats 

menu when you have finished filling in the report 

Columns format window. 

| Type the heading you want to appear at the top of 

the new column. 

Type the formula that will be used to calculate the 

values in the derived column. 

Allowed operators are: 

“ add 
subtract 
multiply 
divide 
evaluate terms in parentheses before other 

terms. You can nest parentheses two deep. 

#n __use the value in column n. 

Enter the column number for the derived column, 

and any commands to produce calculations on the 

new column. 

ieee he seep a nes 

Storing a Report Format 

Steps Choose Create a report format from the Formats 

menu. 
Enter a name (up to 10 characters) in the dialog 

box. 
Fill out the report format window. If desired, define 

one or more derived columns. 

To use a predefined report format, follow the steps 

for printing a report. On the print options window, 

click the button beside the name of the predefined 

report you want to use. REPORT skips the report 

format window and prints the report according to 

the stored format. 

To modify a report format, choose Edit “report 

format name” from the Formats menu and enter 

your changes. 

To remove a report format, choose Edit “report 

format name” from the Formats menu. When the 

form appears, pull down the Formats menu again 

and choose Remove this report format. In the 

alert box, click Ok to remove the format. 
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Changing Headings 

Steps Choose Change headings from the Functions 
menu. 
Type the new heading beside each item you wish to 
change. 
To remove headings choose Undo heading 
changes from the Functions menu. 
When the alert box appears, click Ok to remove 
headings. 
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A Print report 
Start counting 

accessories, desk button, mouse 
Add forms command 
additional disk drive 
add sign 
adjust calculated columns 

keyboard action Cancel button 
speed of double-clicking cancel . 

2-7, 4-12, A-1 boldface printing mode 
alphabetic sort printer codes 
alternate disk Change headings 
Apple menu 
arrow, scroll 3 change 
ascending order column width 
ASCII codes disks 

choose 
different file 

B menu command 
print options 

Backspace key report columns 
backup disk report title 
blank Soha Clear fields command 
blinking question mark Clipboard 
boldfaced printing mode Close All command 
box close box 

close 
New report format application 
Printer codes 
Report Title codes 

button 7 
Cancel to cancel 
dialog box printer 
Eject .. column 
‘heavily outlined calculations 

derived 

formula 



two sorting 
command See also specific 

command 

highlighted 
Command key 

commas in reports 
condensed mode . 
confirm entry See Return and Enter 

| keys 
continuous form paper See fanfold 

paper 
Control Panel 
Copy command 
Copy design only command... .3- 
Copy forms command 
copy See also Copy command and 

Paste command 

count command 
Count forms command 
create 

a new file command 

a report format 
derived column formula 

Cut command 

decimal 
places 
point 

default values 
delete See remove, Backspace key, 

Clear fields and Cut commands 
derived columns 
derived columns window 
descending order 

--desk accessories 

desktop 
dialog box 
dimmed command 

full message 
disk drive, additional 
display report on screen 
divide sign 
double-click 2-2, 4-12, 6-5 
double-click, adjusting speed of .2-8 
drag through a menu 
drive, disk See disk drive, additional 

Edit menu 
Edit ‘report format name” 

edit 
heading changes 
report format 

Eject button 
Eject command 
eject a disk 
Enter key 
enter search information 
erase See remove, Backspace key, 

Clear fields and Cut commands 
error message 
evaluation of formulas 
example file 
exit REPORT 

fanfold paper 
file, copy 
File menu 
Finder 
Finder 

al al lll 



return to 

form 

design window 
formula 

derived column 
incorrect 

self-reference in — 
Functions menu 

hard disk unit 

heavily outlined button 
Help menu 
highlighted See also select 

PFS disk 
shaded 

Imagewriter printer 
insert text 
insertion point, move 
item name 

justification 
K command 
keyboard 

adjusting touch 
special keys on 

keys See also specific key 
rate of repeating 

Keyword command 

Lines per page 
list of PFS files 
load REPORT 

Macintosh | 
computer 
Desk Accessories 

maximum number 
of columns 
of report formats 

menu See also specific menu 
choose from 
dimmed command 
highlighted command 
pull down 

menu 

title 
message, disk is full 
minus sign 
mode 

boldfaced 

condensed 
ultracondensed 

modify 
column width 
headings . 
report format 

mouse, button 
move 

pointer/insertion point 
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N command 
name 

disk file 
report format 

nest parentheses 
New file name 
new page 
new headings 
Next page button 
numeric 

columns 

Ok button 
Open button 
Open command 
open 

Option key 
order of calculations 
organize report columns 

P command 
Page break command 
page width 
paper 

fanfold 
single sheet 

parentheses 
Paste command 

to copy text 
to move text 

Pause between pages 
pointer, move 
predefined report format See create 

a report format 

Print a report command ... . 1-3, 3-2 

printer See a/so Imagewriter printer 
3-6 

print 
special modes 

stop 
using predefined report format 6-3 

without page breaks 3-6 

without page numbers 
print options window 
Print report button 
Print to 

Disk File 
Printer 

program disk 

question mark, blinking 
Quit PFS:REPORT command .. .2-9 
remove See a/so Backspace key, 

Cut and Clear fields commands 
headings 
report format 

report format window 
report rules 
Report Title box 
required equipment 
Return key, using to 

confirm a command .2-7 

return to Finder 2-8 

rules 
for derived column formulas . .5-3 

for numeric columns 4-4 

S 

screen, display report to 
scroll arrow 
scroll box 
search information 
select See a/so double-click 

by double-clicking an item.... 

PT TT 



send ASCII numbers to printer . .3-6 
shaded icon 

Show Clipboard command 
single disk drive 
single sheet stationery 
sort 

alphabetical 
ascending 
descending 
eliminating 
numerical 
on column 2 only 
with a single disk drive .. 

spaces 
in numeric columns 
in keyword files 

spare copy 
special keys 
STAFF example file 
Start counting button 
start 

a new page 
Macintosh 

stop 
printing 
PFS:REPORT 

Subaverage command 
subcount command 
subtotal command 
subtract sign 
switch printer off/on 

text See a/so Cut and Paste 
commands 

terminate print modes 
title line 

title window 
total command 
trailing 

decimal places 

two-drive systems 

U 

ultracondensed mode 
underscore 
Undo headings changes 

command. .2-5, 4-12 
Undo screen changes command 2-6 
uppercase letters 

V/W 

values, default 
warning See alert box 
width 

change column 
page 

window 
choose forms 
form design 
print options 
report format 
derived columns 

word processor 
work file 
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Support Policy 
To participate in Software Publishing’s support service, fill out and return 
the User Group Enrollment card. 

Warranty: Software Publishing Corporation warrants that the PFS program 
disk is free from defects in material and workmanship, assuming normal 
use, for a period of ninety (90) days from date of purchase. If a defect 
occurs during this period, you may return your disk to Software Publishing 
or its authorized dealer, along with a dated proof of purchase, where it will 
be replaced free of charge. 

Program Updates: Software Publishing will notify you of all program 
updates. These new versions may be obtained from Software Publishing 
Corporation or its participating dealer by returning your current disk along 
with a check in the amount specified in the notification letter. 

NOTICE 

EXCEPT FOR THE EXPRESS WARRANTY SET FORTH 
ABOVE, SOFTWARE PUBLISHING GRANTS NO OTHER 
WARRANTIES, EXPRESS OR IMPLIED, BY STATUTE 
OR OTHERWISE, REGARDING THE DISK AND 
RELATED MATERIALS, THEIR FITNESS FOR ANY 
PURPOSE, THEIR QUALITY, THEIR MERCHANTABIL- 
ITY, OR OTHERWISE. 

THE LIABILITY OF SOFTWARE PUBLISHING UNDER 
THE WARRANTY SET FORTH ABOVE SHALL BE 
LIMITED TO THE AMOUNT PAID BY THE CUSTOMER 
FOR THE PRODUCT. IN NO EVENT SHALL 
SOFTWARE PUBLISHING BE LIABLE FOR ANY 
SPECIAL, CONSEQUENTIAL, OR OTHER DAMAGES 
FOR BREACH OF WARRANTY. 

©1984 Software Publishing Corporation 
July 1984 

Software Publishing Corporation 
1901 Landings Drive 

Mountain View, CA 94043 



about this manual 
eee ee 

PFS:FILE is one of a series of easy-to-use programs in the PFS integrated 
Family of Software. This manual explains how to use PFS:FILE with your 
Macintosh computer to help organize and manage the information you use 
every day. | 

To learn PFS:FILE, you first need to know how to use your Macintosh. In 
particular, you should know how to use the mouse, the keyboard, and 
pull-down menus; how to drag the pointer; and how to select an icon. You can 
perform some PFS:FILE tasks in more than one way using these features of 
the Macintosh; however, to simplify instructions, this manual suggests one 
technique for each task. Refer to Macintosh, the owner’s guide, to learn the 
full range of its capabilities. 

This manual contains nine chapters and two appendices. The chapters give 
detailed instructions and examples for using PFS:FILE. Information that 
appears on your Macintosh screen is presented in boldface type to distinguish 
it from other text. The best way to learn PFS:FILE is to read the manual and 
work through the examples on your Macintosh. 

The appendices contain instructions for correcting errors and for estimating 
how many forms can be stored in your file. A quick reference guide and an 
index are also included. 

If you have not already done so, please fill out and return the User Group 
Enrollment Card. Enrollment in this group entitles you to receive product 
update information and tips on using the PFS Family of Software. 
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How PFS:FILE Works 

Getting Started 
What You Need to Use FILE 
Starting FILE 
PFS:FILE Menus 
Using the Edit Menu with FILE 
Special Keys Used by FILE 
Using the Macintosh Desk Accessories 
Stopping Work 
Protecting Your Data Files 
Recommended Backup Procedure 

Creating a New File 
Naming Files 
Designing the File 
Entering the Design 
Editing the Form Design 
Some Further Suggestions on Form Design 
Designing Multiple-Page Forms 
Erasing a Page of the Form Design 
Storing the Form Design 

Adding Forms to the File 
Starting to Add Forms 
Filling in the Form 
Correcting Mistakes 
Guidelines for Filling in Forms 
Entering Dates and Times 
Adding Attachment Pages 
Adding Information to Multiple-Page Forms 
Printing a Copy of the Form 
Finishing Add Forms 



Finding and Updating Forms 
Choosing the Find Forms Command 
Searching for Information in the File 

Full Item Searches 
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The ‘Not’ Search 
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Starting to Print 
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Canceling Print 
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Changing Design with a Single Disk Drive 
Choosing the Change Design Command 
Guidelines for Changing Design 
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Editing Data to Fit the New Design 
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Removing a Blank Page 
Canceling Change Design 
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what is pfs:file? 1-1 

what is pfs:file? 
ee i ee em me eter re te SSS 

PFS:FILE is a computer program that you can use to store and recall 
information you deal with every day. PFS:FILE, or simply FILE, works with all 
kinds of information about people, places, ideas, objects, or events. FILE is 
useful in a wide range of applications, such as business, professional 
environments, home, and education. FILE organizes and stores information 
efficiently, providing easy access to any information you want. Retrieval is fast 
and reliable, and it is not limited by the order in which the information is stored. 

When you use FILE, your information is kept in forms of your own design. A 
form can have as much or as little structure as you wish. Using the Macintosh 
keyboard, mouse, and screen, you design the form you want, save it in a file 
on a disk, and then use it to store your information. 

Here are some examples of the kinds of forms you can design: 

Personnel Information 

" @ File Edit Functions Formats 

Personnel Record Form 
Employee #: Hired: _——— aT 

Name: 

Address: 

City: 



1-2 pfs:file 

Customer List 

re = as ry 

CUSTOMERS @ File Edit Functions Formats 

ACCOUNT # SSSSSSSSSSSSSSS=====- CUSTOMER LIST 

ADDRESS . Account #¢ 

eR Nak en mt 8 

eo 

STATE |e oye i CITY: Zz 

Method of Payments CREDIT RATING: BR SAE OTE 
[METHOD OF PAYMENT: = = ——sSY OF PAYMENT: urehases? 

DATE OF LAST PURCHASE: 
PURCHASES: 

COMMENTS 

Patient Records 

@ File Edit Functions Formats 
AZUK!I MEDICAL GROUP ESE ESOS 

1357 W. SHAW AVE. SS__]SE——]SSSS=> PATIENT RECORDS 
PETALUMA. CA 93711 ae : 

le ee ee eg Fill in page 1 of the design. 
Patient Record 

Soc. Sec. # 565-66-2730 Age 67 

Name Mr. San Miguel 

Address 3199 Frisco Drive 

City Palo Alto State CA Zip 94025 ccupation: 

Fe ae nsurances 

Chronic Conditions Arthritis ill Tos 

Pomc = a ast Treatment Date: 
4/30/78 New, Aver 

110/74 Wha Morn 

@ File Edit Functions Formats 

PATIENT RECORDS 

Fill in page 2 of the design. 

rug Allergies’ 

hronic Conditions: 

istory?: 

reatment Records 
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How PFS:FILE Works 
The PFS:FILE program uses menus that list the functions of the program. You 
indicate the command you want to give by pulling down a menu and selecting 
your choice. Start by creating a new file to store your forms. Design a blank 
form, save it in the file on the disk, and then use it to store your information. 

Personnel Record Form 

Employee #: 13029 Hired: 80/02/01 

Name: Mike Cooper 

Address: 907 Sunset Court 

R Zip: 97208 

Personnel Record Form 

Employee #: 16445 Hired: 80/08/12 
est 

Name: Jennifer Young 

Address: 2421 Broadway 

. s A Zip: 02109 

fill in Personnel Record Form 
form 

Employee #: 01623 Hired: 76/06/14 

Name: Anne Williams 

Address: 67 Westlake Drive 

Personnel Record Form 

Employee #: Hired: 

Once you store the information in the file, you can find it in a variety of ways. 
You indicate what information you want to find by filling in a special copy of the 
form. You can ask for all items that exactly match a given set of characters, for 
example: 
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‘Find the employee record for Peggy E. Miller’ 

@ File Edit Functions Formats 

ee EEE : 

Page 1 -- please choose forms to find. Find first form 

ployee *#: 

Name: Peggy E. Miller 

Address: 

City: 

Job Title: 

Salary: 

or all items that contain a certain set of characters: 

‘Find all customers who have purchased a computer from us’”’ 

@ File Edit Functions Formats 

CUSTOMER LIST 

Page 1 -- please choose forms to find. Find first form 

Name: Account #®- 

Address: State: 

City: 
Phone: 

Credit Rating: 
Hethod of Payment: 

Date of Last Purchase: 
Purchases: ,.computer., 
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If the item is a number, the request can be for all items less than, greater than, 
or equal to a given number: 

‘Find all patients over 65”’ 

" @ File Edit Functions Formats 

PATIENT RECORDS 

Page | -- please choose forms to find. Find first form : 

#i4Home Phone: 
“aBusinmess Phone: 

#4 Occupation: 
#4 insurance: 
aaBill To: 

eLast Treataent Date: 

FILE allows you to enter search information for as many items as you wish. 
Only those forms meeting all your requirements are found. This feature gives 
you access to complex relationships among different items of information. For 
example: 

‘Find all patients over 65 living in Palo Alto, who suffer from arthritis’’ 

” @ File Edit Functions Formats 

SS pariEnt RECORDS 

(Find first form ) | 

Acity: Palo Alta 
Home Phone: 

24Businmess Phone: 
sd 

24 Occupation: 
2] Insurance: 

HBill To: 

“Last Treatment Date: 
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" ¢€ File Edit Functions Formats 

|| Page 2 -- please choose forms to find. Find first form |p 

. Drug Allergies: 

. Chronic Conditions: ,.arthritis.. 

S History: 

. Treateent Record: 

You can display the requested forms on a window for quick viewing (and 

updating, if you wish) or print them for a more permanent record. You can print 

the entire form or selected portions of it, formatted to your specifications. For 

example, you can print name and address information on mailing labels. 

The remaining chapters of the PFS:FILE manual give you detailed 

explanations and examples of how to create, store, and find forms. You also 

learn how to print information and how to change the design of existing forms. 

Finally, you learn helpful file management functions such as copying and 

removing forms from a file. 
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Tee ae a eS oe Saas ‘ERS a SSSA SEES 

This chapter explains how to get started using FILE and lists the equipment 
you need. It also explains how to start and leave the program, how to choose 
commands from the pull-down menus, how to use the Edit menu and desk 
accessories with FILE, and how to use FILE’s special buttons. Finally, it offers 
our recommendations for protecting your data files by frequent backing up. 
When you have finished reading the chapter, and have followed its 
instructions, you will be ready to use the FILE program. 

What You Need to Use FILE 
To use FILE, you need the following equipment: 

s aMacintosh computer with at least 128K memory 

a an Apple Ilmagewriter printer, properly connected to your computer 

» the PFS program disk (A spare copy is also provided, in case the original 
disk is damaged. Store the spare copy in a safe place.) 

= several blank disks for file storage 

= (optional) an additional disk drive or a hard disk unit 

Note: This manual assumes that you do not have an additional disk drive 
connected to your Macintosh. Where procedures differ for two-drive 
systems, they are discussed separately. 

Starting FILE 
You are now ready to begin using the program. The procedure for starting FILE 
is slightly different depending on whether or not your Macintosh is already 
turned on: 

a Ifthe computer is turned on, exit whatever program you are using and eject 
the disk. Then insert the PFS program disk and double-click the icon when 
it appears on the desktop. When you see the Finder, select the PFS:FILE 
icon. 
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a Ifthe computer is turned off, first turn the power on. When requested to 
insert a disk, insert the PFS program disk. At the next window, double-click 
the active disk icon, and when you see the Finder, double-click the PFS:FILE 
icon: 

r 

@ File Edit UWiew Special 

PFS program 

237K in disk 165K available 

Systern Folder Erpty Folder 

Next you see a window asking if you want to create a new file, use an existing 
file, or exit PFS:FILE. This is the PFS:FILE title window: 

@ File Edit Functions 

PFS:FILE 

Create a new file 

Use an existing file 

Exit PFS:FILE 

© 1964 Software Publishing Corporation 
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Notice the oval buttons next to the options in the title window. These oval 
buttons appear on numerous FILE windows. To make a selection using a 
button, position the pointer on it, and click. 

In this situation, if you choose to create a new file, click the button marked 
New. When the next box appears, eject the PFS program disk and insert a 
new disk for data. (If it is an uninitialized disk, you are asked to initialize it and 
give ita name.) Next, type a name for your new file, and click the Ok button. 

lf you choose to use an existing file, a directory window opens, listing the data 
files on your disk. If the file you want to use is on the program disk, click the file 
name and the Ok button (or simply double-click the file name). Otherwise, click 
the Eject button and insert your data disk. 

Note: The directory window can only display six files at a time. If your file disk 
contains more than six files, click and drag the scroll box until the file you 
wish to use appears. 

The following window appears, showing the name of the file you have selected, — 
and directing you to make a menu selection: 

” @ File £3{ Functions Formats 

: SAMPLE SS ——— SS 
. Please make a menu selection. : 

= co 23 cs 

When you are using FILE, you often see this window. FILE displays it when 
you are starting up the program and returns to it after completing functions on 
the Functions menu. 



2-4 pfs:file 

PFS:FILE Menus 
At the top of your Macintosh desktop is a set of titles on the menu bar: File, 
Edit, Functions, Formats (and sometimes Help). These are the menus 
available to you when you are using FILE. To see the commands on each 
menu, position the pointer on the menu title (Functions, for example) and drag 
it down. The Functions menu looks like this: 

Meu Formats 

Find forms 
. Add forms 

: Please make @ rin? this farm 
Rempup This Paqryy 

Copy forms 

Copy design only 

Change design 

To choose a menu command, drag the pointer down and release the mouse 

button on the line of your choice. Notice that some of the commands on the 

Functions menu appear in highlighted letters; others are dim. Menu 

commands you can perform at a particular stage of the program are 

highlighted; commands you can’t use at that time are in light letters. (FILE 

won’t let you choose an inactive menu command.) 
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= Using the Edit Menu with FILE 
= When you enter or update information with FILE, you may find it convenient to 

use some of the Edit menu features. The PFS:FILE Edit menu looks like this: 

a - Pile MSU HUACUONS- ROCMMS oe tere eit em ast, 
Oe Seat Pe eee ee eRe. esc ae ara =a 

f net ee : 

BSG #8 

Paste current date 30D 

— : Paste current time 

Clear fields 
/ Show Clipboard 

You can cut one item of information at a time, store it temporarily on the 
=i Clipboard, and then paste it into another location. Or, you can copy the 

information you have cut. To see the contents of the Clipboard, choose the last 
< menu command, Show Clipboard. 

If you review changes you have made to a form and find them unacceptable, 
| you can choose the Undo screen changes command to restore the form to its 

Original state. 

Suggestions for using the Edit menu features appear in chapters where they 
= may be helpful. You can learn more about the full set of Edit features from 

Macintosh, your owner’s guide. 
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Special Keys Used by FILE 

As you work with FILE, you usually use the mouse to move the pointer and to 

perform other desired tasks. Sometimes, however, it may be more convenient 

to keep your fingers on the keyboard and perform specific actions from there. 

The keys you can use are described below: 

ey 

Backspace 

What It Does 

Confirms whatever entry you’ve made on a window so 

that FILE moves on to the next step. In an alert box, 

pressing the Enter key is the same as clicking the heavily 

outlined oval button (Ok for example). 

Moves the insertion point (the blinking bar) to the 

beginning of the next line. Using Return in an alert box is 

the same as clicking the heavily outlined oval button. 

When filling in a form, Tab moves the insertion point 

forward to the next item. With the Shift key pressed, Tab 

moves to the previous item. (You can also click on an 

item once to move the insertion point automatically to 

that item.) 

Moves the insertion point to the left one space and 

erases the character in that location. 

Used in combination with the following keys, Command 

is a shortcut to choosing a command from the Edit menu. 

X = Cut 
C = Copy 
V = Paste 
D = Paste current date 
T = Paste current time 

Used in combination with certain keys, Option lets you 

enter accented and special characters. These are 

discussed in Appendix A of your Macintosh owner's 

guide. 
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Using the Macintosh Desk Accessories 
The full range of Macintosh desk accessories is available for you to use with 
FILE. For example, you might want to decrease the speed at which the 
Macintosh interprets your double clicks to select icons or open files. Or, you 
might want to adjust the keyboard action to produce repeating characters at 
only a very light touch. With PFS:FILE, you choose a desk accessory just as 
you choose any menu command. Pull down the Apple menu at the far left of 
the menu bar, and choose any desk accessory command. 

Note: With FILE, you may use only one desk accessory at a time. If you have a 
data disk in the drive when you choose a desk accessory, the disk is 
ejected, and you are asked to insert the PFS program disk. 

Stopping Work 
When you want to stop using PFS:FILE, you can either quit work altogether or 
move to another program. To quit work on your Macintosh altogether, pull down 
the File menu and choose Quit PFS:FILE. Then close all files, eject the disk 
and turn the Macintosh off. 

You can stop using FILE and start work on PFS:REPORT or on another 
program. To do so, pull down the File menu and choose the Quit PFS:FILE 
command. After a short pause, a window will display all the programs on the 
disk in the drive, and you can select another one to work on. 

If the program you want to use is not on the disk in the drive, you can click the 
close box or choose the Close All command from the File menu. Either action 
will close the files on the disk. After closing the files, choose the Eject 
command from the File menu and remove the disk from the drive. Then 
replace the disk with the one you want to use and begin work. 

Note: If you choose to eject the disk without closing all files, the PFS:FILE disk 
becomes an “‘alternate’’ disk, displayed as a shaded icon on the 
desktop. If the Macintosh needs the alternate disk later, it asks for it. 
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Protecting Your Data Files 
By the time you have created a file and entered information into it, you will 

have invested a good deal of your time. To avoid losing the data stored in that 

file (and the time you have spent entering it), follow these guidelines: 

= Never turn your Macintosh off unless you have exited PFS:FILE. IF YOU oes 

DO, THE FILE MAY BE PERMANENTLY DAMAGED. + 

a Use only high-quality disks. 

= Handle your disks carefully. Although your 3-1/2 inch disks are sturdier than 

floppy diskettes, they do require care. Store them away from heat, sunlight, 

and devices with strong magnetic fields (TV’s, etc.). In addition, avoid 

touching the exposed disk under the metal covering. 

= Always keep at least one extra, or backup, copy of each file. See our backup — 

recommendations below. | 

= Print acopy of your files from time to time. See Chapter 6 for instructions. 

Recommended Backup Procedure 
1. Procedures for copying files vary depending on whether your Macintosh 

system has one or two drives. Both copy procedures involve selecting the 

icon that represents the file you want to copy and dragging the icon to 

where you want to copy the file. These are the principle differences in the 

procedures (see Macintosh, the owner’s manual for details): 

= With a single disk drive, you are asked to alternate the original disk and 

the destination disk as many times as necessary to copy the complete 

file. Screen instructions prompt you each step of the way. 

a With two disk drives, the file is copied without prompting for disk — 

swapping. 

2. Back up your data files on a regular basis. If you update them daily, then 

back up daily. If you update less often, back up whenever you update. 

3. After creating a new data file, make two backup copies. Thereafter, 

alternate their use. The first time you back up, use the first disk; the next 

day, use the other disk; and so on. This way, if a problem develops while 

making a backup, you still have the data on the other backup disk. 
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. If you encounter problems with a file or get an IO error message (see 
Appendix A), remove the disk at once and use the backup disk. (Make a 
copy of the backup disk first.) If the problem recurs with the backup disk, 
ask your Macintosh dealer for help. 

In this chapter you have learned how to start and exit PFS:FILE. You have 
learned how to use some of the special Macintosh features and menus with 
the program and have received suggestions on protecting your data files. In 
the next chapter you will learn how to design a file for your data. 



Ce
t 

a 
a 
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creating a new file 
ERAS 

This chapter explains how to create a file to store information. By following 
along with the example, you create a sample file that stores typical personnel 
information for six employees. 

You create a file by giving it a name and opening the disk on which you wish to 
store it. Next, you design the form by typing the names of items as you wish 
them to appear and then store your design in the file. Later, you fill in the form 
with information, and FILE stores that information in the same file. 

To create a file for storing information, start the FILE program according to the 
directions in Chapter 2. When the PFS:FILE title window appears on the 
screen, move the pointer to the New button and select it. 

@ File Edit Functions 

PFS:FILE 

Create a new file 

Use an existing file 

Exit PFS:FILE 

© 1984 Software Publishing Corporation 
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| A dialog box appears next. Eject the PFS program disk and insert another 
disk on which to create your data file. (Initialize and name the data disk, if : 

| necessary.) The dialog box you use looks like this: 

. @ File Edit Functions 
me 

lo 

New file name 

Naming Files 
PFS file names follow the same rules as for other Macintosh files: A file name 
can be from one to 40 characters long, and it can include any characters on _ 
the keyboard except a colon (:). It cannot begin with a period (.). Here are 
several sample file names: , 

index 3 ; 
RED WINES 

i Dr. Smith’s Patient Records (1984) 
Bibliography for Article ““Oceanography’’ ~ 

Remember that no two documents on a disk can have the same name and that 

the Finder does not distinguish between upper and lower case letters. For 5 
example, Macintosh would consider RED WINES to be the same file name as 
red wines. 

| At the dialog box, type EMPLOYEES, to give the sample personnel file its a 
| name. Then, click the Ok button. 
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Designing the File 
As soon as you open the disk for your new file, a window opens on which you 
can enter your design: 

" € File Edit Functions Formats 

=| Fillin page 1 of the design. : 

FILE uses the title bar and the area above it to tell you: 

a the name of the file you are creating (EMPLOYEES) 

a the page number of the form design 

a the titles of the pull-down menus you can choose from 

Entering the Design 
When you design a form, you create a place to put your information. Using the 
mouse, keyboard and screen, you create an image of the form you want. When 
you design forms of your own, you can model them on familiar paper forms 
you have on hand, or you can use the following guidelines to set up new forms: 

= Decide how to arrange the information you wish to store in your file. 

=» Choose names that best describe each item of information. 

a Determine approximately how much space you should leave for each item 
of information. 
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You are now ready to design the form to use for storing information. Suppose 
you want to create a form that looks something like this: 

Personnel Record Form 

Employee #: Hired: 

Name: 

Address: 

City: 

To enter the item names, simply move the pointer to where you want them to 
appear and type them onto the window. You can use the mouse to position the 
pointer, or keep your hands on the keyboard and use the following keys: 

Return Positions the insertion point at the beginning of the next line. 

Space bar Moves the insertion point along a line. 

For the purposes of the exercises later in this book, don’t include the title 
Personnel Record Form. Do be sure to enter each item: Employee #, 
Hired, Name, Address, City, State, Zip, Job Title, and Salary. End each 
item name with a colon. You can continue moving the pointer around the 
window, making additions and corrections to your form, until it looks like 
this: 

@ File Edit Functions Formats 

EMPLOYEES 

Job Title: 

a Salary: 
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Editing the Form Design 
While you are designing your form, you may find it helpful to use the Edit 
menu. It contains several commands to help you correct mistakes or rearrange 
the format of the items on the window. 

To move an item, drag the pointer across it. Then choose Cut from the menu. 
Next, select the insertion point by clicking where you want the item to go, and 
choose Paste from the menu. 

To copy an item, drag the pointer across it and choose Copy from the menu. 
Next, select the insertion point by clicking where you want the item to go, and 
choose Paste from the menu. 

To replace an item, drag the pointer across it and type in your new text, or 
choose Paste from the menu to replace the item with what was last cut or 
copied. 

To remove an item, drag the pointer across it and press the oo key or 
choose Cut from the menu. 

When you design your form, you may find that you need to add or delete lines. 
Since FILE comes set to work automatically in the insert typing mode, simply 
press the Return key to add a line. Any characters to the right of the cursor 
move down. To delete a line, select the line by dragging across it and press the 
Backspace key. 

Note: If the bottom line of your form contains information, FILE cannot insert 
text or blank lines elsewhere in the form. To enter another item or another 
line, you need to delete the bottom line or remove blank lines elsewhere 
on the form. 

Some Further Suggestions 
on Form Design 
Each section set aside for information (and later the filled-in section) is called 
an item. As you are designing your form, keep in mind these sacl points 
about items: 

u Leave plenty of space for each item. This practice does not take more space 
on your disk and is important because your form is used for both storing and 
retrieving information. When you use the form to retrieve something, your 
instructions for retrieval may actually require more character positions than 
the data itself. 
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For example, an item named Page may be designed to store a maximum of 
three digits. If you design your form with only three spaces following Page, 
you cannot ask for ‘‘all pages numbered lower than 100,”’ because the 
required format requires four spaces. The format looks like this: < 100. 

Make the first item in your form the one you will look for most frequently. 
This provides the fastest possible retrieval. When FILE is searching for the 
first item on a form, it can go directly to the desired form in the file. When 
FILE is searching for other items in the form, it searches through each form 
in the file from the end of the file forward. This type of search takes longer. 

When FILE prints out information from your files, it prints items in the order 
in which they appear on the form. Design your form with this in mind. For 
example, suppose you want to print mailing labels from a file. Your forms 
must be set up in the order of a standard mailing address (name, address, 
city, state, zip code), or you will not be able to print a mailing label with the 
items in that order. Note that the items you choose for printing do not have 
to be adjoining, just in the proper order on the form. 

If you would like to have the same information stored in two different ways 
for different purposes, set up two items with different names. For example, 
have a Last Name item for fast searching and sorting customers by last 
name, and have a Name item for keeping names in the format you would 
use ina mailing address. 

Terminate each item name with a colon. Any character entered on the 
window during the design process is part of some item name, and the colon 
identifies characters as item names for the FILE program. For example, 
suppose the form from the PATIENT RECORDS file mentioned in Chapter 1 
looked like this: : 

" @ File Edit Functions Formats 

PATIENT RECORDS 
|| Fill in page 1 of the design. 

Business Phone: 

a F 
eaOccupatians: 
fa |risurance; 
SBill Tos 

Glast Treatment Oate; 
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SS# is an item name, and so are Age and Date. The line of dashes inserted 
between the first and second lines of the form is a part of the Name item. 
(Every non-blank character between the colon ending the Date item and the 
colon ending the Name item is part of the Name item.) 

Designing Multiple-Page Forms 
A form can consist of more than one page, though the window can only show 
one page at a time. Each page can contain a maximum of 100 items. If you 
need more than one page for a form, you can create up to 31 additional pages. 
Then you can move back and forth between pages, like turning pages ina 
booklet, by clicking the arrows at the right side of the window in the direction of 
what you want to see: 

Clicking this arrow brings up the next page of the form (in this 
case, a blank page). You can continue to type more item 
names. 

Clicking this arrow recalls the previous page of the form to the 
window. You can review it and make changes, if you wish. 

As you move through your multiple-page form, you’ll see the current page 
number displayed in the message area at the top of the window. An asterisk (*) 
appearing to the right of the page number indicates that the form has additional 
pages containing data. 

Erasing a Page of the Form Design 
lf you want to erase a page of the form design, display that page, pull down the 
Edit menu, and select the Ciear fields command. The currently-displayed 
page of the form is erased, while other pages remain unchanged. Erasing a 
page does not remove the page from the form design, but merely turns it into a 
blank page. To remove it, you need to redesign the form. See Chapter 7 for 
information on changing the design of a file. 
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Storing the Form Design 
FILE stores your form design automatically as you enter it on the window. 

When you are satisfied that the blank EMPLOYEES form has all the right items 

in the right places, you are ready to start adding information in your file. Should 

you want to leave PFS:FILE at this point, you can do so by pulling down the 

File menu and selecting the Quit PFS:FILE command. Your file design is 

saved for you and you can begin adding forms at another time. 

In this chapter you learned to design a form for the information you want to 

have on file. In the next chapter you will learn how to enter and store 

information in the file. | 
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adding forms 

det =e 2S SSS SSS SE 

This chapter explains how to enter information in a file using the Add forms 
command on the Functions menu. Using Add forms, you fill in the blank form 
with the information you want to keep, and that filled-in form is stored in the 
file. In this chapter, you use the personnel form you designed for the sample 
EMPLOYEES file for practice. 

The number of forms that can fit on a disk depends on the capacity of the disk, 
how many pages are in the form, how many items there are per page, and how 
much data is entered in each item. See Appendix B for an explanation of how 
to calculate the approximate number of forms that fit on a disk in a given 
situation. 

Starting to Add Forms 
Let’s add information to the EMPLOYEES file. First, pull down the Functions 
menu and choose the Add forms command. Page 1 of the new form appears, 
displaying a blank form in the EMPLOYEES file: 

Fr = S| 

@ File Edit Functions Formats 

: Fill in page 1 of the new form. | Continue adding 

: Emp loyee*: 

=] Name : 

Address: 

a City: 

Job Title: 

: Salary: 



4-2 pfs:file 

When you enter information on this window, FILE protects item names so you 

cannot accidentally write over and destroy them. 

Filling in the Form 
Now you are ready to add information to the EMPLOYEES file. The insertion 

point is positioned in the Employee # item. Type 01623. Then press Tab to 

move to the next item Hired and type 76/06/14. Continue pressing Tab to move 

to each item, and type in the rest of the information shown below. 

" € File Edit Functions Formats 

| Fill in page 1 of the new form. Continue adding|{ 

/ Eaployee®-0 1623 Hired: 76/06/14 rp 

- Name: Anne Williams 

a Address: 67 Westlake Orive 

ACity: Los Altos Zip: 94022 

: Job Title: Manager 

LT lalla 
S Salary: $3500.00 

Click the Continue adding button and FILE allows you to add another form. 

(Note that pressing the Enter key performs the same function as clicking the 

button). The blank form now reappears and you are ready to fill in the 

information for the next form. Type the following information into the form: 

Employee #:13029 Hired: 80/02/01 

Name: Loren Herbert 

Address: 907 Sunset Court 
City: Portland State: OR Zip: 97208 

Job Title: Salesperson-West 
Salary: $1900 
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Fill in the next three forms with the information shown here. When you have 
finished a form, move to the next form by clicking the Continue adding button. 

Employee #: 09883 Hired: 76/04/15 

Name: Ted Russell 
Address: 437 Oak Street 
City: Palo Alto State: CA Zip: 94301 

Job Title: Engineer 
Salary: $2500 

Employee #: 07531 Hired: 77/06/29 

Name: Sara Brown 
Address: 1552 Bay Road | 
City: Menlo Park State: CA Zip: 94025 

Job Title: Secretary 
Salary: $1200 

Employee #: 10764 Hired: 79/10/23 

Name: John Andrews 
Address: 6811 Cypress Lane 
City: Dayton State: OH Zip: 45401 

Job Title: Salesperson-Midwest 
Salary: $1850 

Correcting Mistakes 
lf you make a mistake while entering data into a form, you can easily correct it. 
If the mistake is in the same item as the insertion point, use the Backspace key 
to erase the last few characters and retype the correct information. 

If the mistake is in another item on the same page, use the Tab key or mouse to 
move the pointer to the first or last character in the mistake, drag across it, and 
then type in the correct information. If the mistake is on another page, click the 
scroll arrow in the direction you wish to go and when you reach the page you 
want, move the pointer to the item and correct it. 
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To erase an entire item, move the pointer to the first or last character, drag 
across it and press the Backspace key. (You can also double-click the item 
name and press Backspace to erase its contents.) If you want to keep the item 
on the Clipboard instead of deleting it altogether, use the Cut command from 
the Edit menu. To erase the information in all the items on the current page of 
a form, pull down the Edit menu and choose the Clear fields command. This 
erases all the information on the page and returns the pointer to the first item. 

Guidelines for Filling in Forms 
You can add forms to files in any order you like. There is no need to enter them 
in alphabetical or numerical order. FILE takes care of finding the desired 
information when you need it. When you are creating your own files, keep the 
following points in mind: 

a If you know that your data will require more than one disk, presort it into 
groups according to your needs. For example, if you want to sort your forms 
by zip codes, make sure that all forms with zip codes beginning with 0 are in 
one file, and all those beginning with 1 are in another, etc. 

Enter last names first to have FILE search your files or sort and print them in 
alphabetical order by last names. See Chapter 6 for details. 

Enter numbers after determining the longest number you are likely to use. 
Then enter numbers so that they are all the same length. You may need to 
use leading zeroes as placeholders. For example, if your highest numbers 
are in the thousands, enter 9 as 0009. When sorting, FILE looks at numbers 
as simple character strings; thus, 1000 would be sorted before 9 and after 
0009. 

If you plan to use your data file with PFS: REPORT, limit the size of numeric 
items to twenty digits, since that is the maximum number of digits 
PFS:REPORT processes. 

Entering Dates and Times 
FILE has a special way of working with dates and times entered into a form. 
You entered dates of hire into each personnel form you created in the 
EMPLOYEES file. These dates were in a YY/MM/DD format with two digits in 
each component. This format makes it easier for FILE to search for specific 
dates and manipulate them. 

Similarly, times are best stored in a 24-hour format, HH:MM, as in 13:45 for 
1:45 p.m. Minutes must be entered with two digits; the hours 1:00-9:00 may be 
represented with only one digit, if you choose. 
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If you follow these conventions, you can get reports sorted in order by date 
from PFS:REPORT and can search the file for times greater than (later) or less 
than (earlier) a particular time of day. 

The following Edit menu commands automatically enter the date and time in 
the suggested manner: 

Paste current date FILE enters the current date at the insertion point in 
the form YY/MM/DD 

Paste current time FILE enters the current time at the insertion point in 
24-hour format (HH:MM) 

Adding Attachment Pages 
Attachment pages appear after the last page of your form. They allow you to 
add extra information at the end of a particular form. When the last page of 
your form is displayed and you click the downward scroll arrow, a new page 
with an item named Attachment appears. For example, enter the following 
information for the sixth employee in the EMPLOYEES file: 

Employee #: 16445 Hired: 80/08/12 

Name: Jennifer Young 
Address: 2421 Broadway 
City: Boston State: MA Zip: 02109 

Job Title: Salesperson-East 
Salary: $1950.00 

For this form, there is some additional information. Since the EMPLOYEES 
form only contains one page, add an Attachment page by clicking the 
downward scroll arrow, and the Attachment window appears. 
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" @ File Edit Functions Formats 

SSS = EMPLOYEES 

. Attachment : | 

Type in the following additional information at the insertion point: 

Has had two years of European experience. 

If you want to review the information entered on the previous page, you can 
click the upward scroll arrow to return to Page 1. You can store the filled-in 
form regardless of which page is displayed on the window. Click the upward 
scroll arrow, and notice that there is an asterisk to the right of the page number. 
The asterisk indicates that this form has an additional page containing data. 

You can add Attachment pages to a form until you run out of room on the disk. 
Use this attachment feature when you need to add some special information to 
a particular form. If you forgot to include an item needed on many forms when 
you designed the form, use the Change design command on the Functions 
menu (see Chapter 7). 

Adding Information to Multiple-Page 
Forms 
If your original form design was two or more pages, you can move through a 
multiple page form with the same scroll arrows you used to move to 
Attachment pages. 



adding forms to the file 4-7 

Printing a Copy of the Form 
If you want to print a copy of the information you have entered on a form, pull 
down the Functions menu and choose the Print this form command when 
any page of the form is on the window. You might want to use this option to 
print a copy of your blank form, or to print a copy of each form that you fill in 
and add to an already established file. When FILE displays the print options, 
click Ok. FILE begins printing the form (all pages), using the default values for 
those options. (See Chapter 6 for a description of the print options.) 

Finishing Add Forms 
You may pull down another menu and choose another command at any time, 
to stop the Add forms process. FILE saves all the information that you enter, 
including incomplete forms, if you decide to stop the Add forms process 
before finishing a page. If you wish to erase an incomplete form before 
stopping the Add forms process, choose Remove this form from the 
Functions menu. i 

This chapter has told you how to add forms to a file. In the next chapter 
you will learn to use the program to find, update, and count the forms in 
your file. 
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This chapter explains how to find and update and count information in a file. 

Using the Find forms command, you indicate which forms you want to review. 

FILE searches for the forms that qualify, and displays them on the window. 

FILE also tells you the number of forms that meet your specifications. When a 

form is on the window, you can remove it, print a copy of it, or update the 
information previously entered. 

Choosing the Find Forms Command 
Let’s search for information from the EMPLOYEES file in several ways. Start 

by selecting PFS:FILE, as you have done before. Then choose to open the 
existing file, EMPLOYEES. Pull down the Functions menu and choose the 
Find forms command. Your window looks like this: 

€ File Edit Marechitss Formats 

Add forms 

Print this form 

ARE ies Remove this form 

Copy forms 

Copy design only 

Change design 
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When you see the following form, you specify items you want FILE to search 
for, so that you can review and update them: 

" € File Edit Functions Formats 

EMPLOYEES 

=| Page 1 -- please choose forms to find. [_Find first form ]} 

. Eaployee®: | 

=] Name - 

#4] Address: 

ACity: 

Job Title: 

S Salary: 

Searching for Information in the File 
FILE can search for information in five ways: full item searches, partial item 
searches, numeric item searches, numeric range searches, and the ‘‘Not’’ 
search. Each of these search methods is discussed in detail below. 

Full Item Searches 

In a full item search, FILE looks for forms on which the characters in an item 
exactly match the characters that you entered in the same item on the window. 
(A character can be a letter, anumber, or a punctuation mark; letters may be 
entered in upper or lower case.) 

To determine whether there is a match, FILE uses the following rules: 

u FILE ignores spaces before the first character and after the last character. 

a FILE treats multiple spaces within the items as a single space. 

a FILE does not distinguish between upper and lower case. 

If you do not enter any search information, FILE displays all the forms in the 
file, starting with the form you most recently entered. You may enter search 
information in as many items as you wish; FILE finds only those forms that 
match the information in all respects. 

LSE LR EL LEI TL I ED EE ST EP SEE BSS aT TS TEE 6 IT RPT NSE SE ESET TIE 
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For example, let’s recall the John Andrews form of the EMPLOYEES file to the 
window. Type John Andrews in the Name item, as shown below: 

” @ File Edit Functions Formats 

3 EMPLOYEES 

| Page 1 -- please choose forms to find. [ Find first form |} 

. Eaployee*- : 

=| Name: John Andrews 

7 Address: 
Bee 

SiJob Title: 
on 
4 

Now click the Find first form button, and FILE searches through the 
EMPLOYEES file for forms that exactly match the information you have 
entered. In this case, FILE searches for forms with John Andrews in the Name 
item. When FILE finds the match, it displays the form for you to review and 
update. 

FILE’s full item search would also find the following entries: 

Name: John Andrews 

Name: JOHN ANDREWS 

On the other hand, the following entries would not be matches, because they 
do not contain exactly the same information as you entered. 

Name: Mr. John Andrews 

Name: John Andrews, Jr. 

Name: John 

Name: Andrews, John 

Name: JohnAndrews 

Keep these pointers in mind when searching for forms to update: For the 
fastest possible retrieval, use the full item search. If you use a full item search 
in the first item of your form, FILE can find any form in 2 seconds. 
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Partial Item Searches 

Use a partial item search if you do not remember exactly how an item of 

information is entered in a file, or if you want to find occurrences of specific 

items of information in your files. There are two kinds of partial item searches: 

the ..search.. and the ? search. 

The ..search.. uses pairs of dots with a word or group of words (or number or 

group of numbers) to search for an occurrence of certain information within an 

item. It works like these examples: 3 

..XYZ Tells FILE to ignore whatever characters occur before xyz. 

abc.. Tells FILE to ignore whatever characters occur after abc.. 

..par.. Tells FILE to ignore whatever characters occur before and 

after par and to search for pqr anywhere in the item. 

Tells FILE to find all forms with any characters in this item. 

For example, suppose you want to recall Jennifer Young’s personnel form to 

the window. Jennifer likes to be called Jenny, and you don’t know exactly how 

the name was entered in the EMPLOYEES file. Using the ..search.. there are 

three ways you can find Jenny’s form. For example, enter these characters: 

” @ File Edit Functions Formats 

Sa EMPLOVEES 

| Page 1 -- please choose forms to find. Find first form : 

. Eap!loyee* : 
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Then click the Find first form button, and FILE begins searching for partial 
items that match. If you had these forms stored in the EMPLOYEES file, all of 
them would be displayed as partial item matches: 

Name: Jenny 

Name: Jennifer Young 

Name: Jenny Jones 

However, the following entry would not be a match: 

Name: Ms. Jennifer Young 

Another way to search for Jennifer’s form is to enter this search information: 

" € File Edit Functions Formats 

|| Page 1 -- please choose forms to find. Find first form |} 

S Eap loyee*: 

. Salary: 

All of the following would match: 

Name: Ms. Young 

Name: J. Young 

Name: Ms. Jennifer Young 

Name: Jenny Young 

Name: Steven Young 
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The third way is to enter this search information: 

r 4 3 
@ File Edit Functions Formats 

These three entries would be found: 

Name: JENNIFER YOUNG 

Name: Ms. Jennifer Young 

Name: Jennifer Younger, C.PA. 

Now suppose you want to look at the forms of all the employees who have 

work experience in Europe. You know that this information was entered on an 

attachment page. If you enter search information so that your screen looks like 

this, 

Attachment: ..Europe.. 

both of the following forms would match: 

Attachment: Has had two years of European experience. 

Attachment: Worked in Europe for two years. 

The ? search uses the question mark as a “‘wild card” character to search for 

items that are almost an exact match. This symbol can be entered on the 

window to represent any single character. When FILE searches, it accepts any 

character in that same position as a match. 
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For example, suppose the second digit of a part number indicates its color, and 
you want to find all forms listing the part regardless of color. If you enter the 
following search information, 

PART NUMBER: 37711 

FILE retrieves all forms listing the part with any color. 

As another example, assume that you know that there are two people in the 
EMPLOYEES file who were hired in June of 1977, and you want to find their 
forms. You would use the following search information: 

" « File Edit Functions Formats 

Page 1 -- please choose forms to find. Find first form : 

Employees: Hired:77/06/?? 

Numeric Item Searches 

There are two ways to use numbers as search information. One way is to use 
the number as a set of characters that identifies an item. In this case, the 
number has no numeric value — one number is not typically thought of as 
larger or smaller than any other. Phone numbers, part numbers, and social 
security numbers are examples of numbers used as identifiers. FILE treats the 
numbers as it would treat a word or any string of identifying letters. You use 
either a full item search or one of the partial item searches to look for such a 
number. 
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For example, if you want to search through the EMPLOYEES file for employee 
number 13029, the window would look like this: 

" € File Edit Functions Formats 

Page | -- please choose forms to find. Find first form : 

Eaployee®: 13029 

S] Name - 

=| Address: 

{Ci ty: 

| Job Title: 

Salary: 

The other way is to use the number to represent a numeric value — something 
that has a meaning of larger or smaller associated with it. Numbers associated 
with quantity or cost are examples of numbers used to represent arithmetic 
values. When searching through forms for such a number, it is possible to look 
for all items less than, greater than, or equal to that given number. When you 
want to search for a numeric value, enter one of three special symbols (<, >, 
and =) followed by the desired number. 
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For example, suppose you want to search through the EMPLOYEES file for all 
the employees with salaries greater than $2000.00. The search information 
should look like this: 

" @ File Edit Functions Formats 

EE EMPLOVEES 

| Page 1 -- please choose forms to find. | Find first form | : 

dW 
Salary: >2000.00 

In determining the value of a number, FILE uses the following rules: 

~ m FILE ignores all characters other than -, ., 0, 1, 2, 3, 4, 5, 6, 7, 8, 9. (Be sure 
to use the number 1 rather than lower case | and the number 0, not the letter 
O.) 

=» Aminus sign (-) appearing before the first digit or after the last makes the 
value negative. FILE ignores multiple minus signs. 

a If FILE encounters multiple decimal points (...), it ignores all but the first. 

Below are some examples of how FILE assigns an arithmetic value to a 
number following one of these symbols (<, >, or =). 

Item Value Explanation 

3 $1,706.22 1706.22 $ and , are ignored 

138 MAY 1980 131980 MAY is ignored 

70-06-29 700629. — is ignored; the — must be before or after the 
number to be interpreted as a minus sign 

20:45 _ 2045 : Is ignored 

FIVE 0 letters are ignored f 
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Numeric Range Searches 

The numeric range search allows you to search for numeric values within a 
certain range. To do this, use an equals sign followed by the lowest of the 
numeric values, two dots, and then the highest numeric value. The dot-dot 
with the equals sign means ‘“‘through.”’ 

For example, to find all employees in the EMPLOYEES file hired between 
January 1, 1982, and December 31, 1983, the search information should look 
like this: | 

" @ File Edit Functions Formats 

——— = EMPLOVEES 

Hired: =82/01/01,. 

Note: You can put spaces anywhere except between the dots. 
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The “‘Not’’ Search 

Any of the searches can have its intent reversed by preceding it with a slash 
(/). For example, suppose you want to search through the EMPLOYEES file for 
all employees with salaries less than $1500.00 or more than $2000.00. The 
search information would look like this: 

" @ File Edit Functions Formats 

| Page 1 -- please choose forms to find. Find first form | f 

Here are some other examples of FILE’s ‘‘Not’’ search: 

f=3e1 Finds all those values which are NOT equal to 3.1 

JOHN Finds all those items that are NOT JOHN 

/B.. Finds all those items that do NOT begin with B 

/..er Finds all those items that do NOT end with er 

/ = 31..100 Finds all those items less than 31 or greater than 100 

fe Finds all those items that are blank 

How FILE Searches 
When you have entered all your search information, click the Find first form 

button, and FILE searches for the desired forms, starting with the form most 
recently added. 
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What to Do with a Form that FILE Finds 

When FILE finds a form that meets the search information, it displays it on the 

window and waits. You can do any of the following: | 

Update the Form 

You can make any changes to information stored in the form by positioning the 

insertion point in the item you want to change and entering new information. 

Then click the Find next form button, and FILE stores the updated form in the 

file and continues its search. 

lf you make changes to a form, but decide that you do not want to save the 

changes, move the pointer to the Edit title on the menu bar. Pull down the Edit 

menu and choose Undo screen changes. The form on the window is restored 

to its previous, unchanged state. : 

Review the Form 

If your form has multiple pages, you can browse through the form, using the up 

~ and down scroll bars on the right-hand side of the form. When you finish, click 

the Find next form button, and FILE continues its search. 

Print the Form 

You can print all pages of the form displayed on the window. After reviewing a 

form, choose Print this form from the Functions menu. FILE prints a copy of 

the form, using the default print options. (See Chapter 6 for a description of the 

print options.) | 

Walalalallalel 
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Remove the Form 

You can remove all pages of the form displayed on the window. Simply move —~ 
the pointer to the Functions menu, and drag to the Remove this form 
command. Before the form is removed, the following message appears: 

" & File Edit Functions Formats 

a EMPLOYEES 

|| Edit page 1 of the form. Find next form |p 

| Employee®: 10764 Hired: 79/10/23 

ig Remove this form? 

Click Ok to remove the form. If you change your mind, click Cancel instead. 

Canceling Find Forms 
You can cancel the Find forms command at any time. Simply move the pointer 
to a title on the menu bar, pull down any menu, and choose another command. 
If you are updating a form when you leave the Find forms command, those — 
changes to the form are recorded in the file. 

Counting Forms 
A related command to Find forms is the Count forms command. Like Find 
forms, Count forms uses search information. However, it uses the information 

to count the number of forms you have in a specified group without allowing 
you to update the individual forms that match. 
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For example, using the EMPLOYEES file once again, let’s quickly count the 
number of people living in a zip code region that starts with the number 9. 
Choose Count forms from the Functions menu. In the Zip item, enter 9.., and 
click the Start counting button. When all the forms have been counted, you 
see this message: 

@ File £43: Functions Formats 5 

In this chapter you have used FILE to find, update, and count forms. The next 
chapter tells you how to print information from selected groups of forms. 
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There are two ways to print your forms. First, when you are working with a 
particular form, you can print that form only by choosing Print this form from 
the Functions menu. Second, you can print all of the forms ora group of forms 
by selecting Print forms. 

You can also print selected items from forms ina file according to a format that 
you specify. This format might include printing the forms in sorted order; for 
example, in alphabetical order for an item named City. You can also save a 
print format for use at a later time. 

Starting with the Print forms command on the Functions menu, you choose 
which forms you want to print, which items of each form you want to print, and 
how you want to print them. FILE then searches through the file, automatically 
printing all the selected information. 

Starting to Print 
To practice printing, open the EMPLOYEES file, if it is not already open. Move 
the pointer to the Functions title on the menu bar, and choose Print forms. 
The first window you see contains the EMPLOYEES file form design, just like 
the one you used for entering search information in Chapter 5. 

To illustrate the printing process, let’s print mailing labels for all the employees 
in the EMPLOYEES file. (For the purposes of the exercise, use ordinary printer 
paper instead of mailing labels, if you wish.) You can practice all three of the 
steps in the printing process: choosing which forms to print, choosing among 
print options, and setting up your print format. A separate window appears for 
each step. 
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Choosing Which Forms to Print 

When you choose the Print forms command, the form design for the 

EMPLOYEES file appears, ready for you to enter search information: 

4 

r 2 iB 4 
& File Edit Functions Formats 

| Page 1 -- please choose forms to print. Print forms | 

Since you want to print mailing labels for all the employees in the EMPLOYEES 

file, leave the form blank and click the Print forms button to continue. 

Note: If you want to print only some of the forms in your file, fill in the form 

according to the instructions in Chapter 5. You can enter search 

information in any item on a form. 
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Filling in the Print Options 
Next, FILE displays a window for you to decide among several print options: 

File Edit Functions Formats 

Print to @ Printer © Disk File 

(] Print item names [] Pause between pages : 

Lines per page Number of copies bese 7 

ae) 

This form initially shows common settings, called default values, for the print 
options. To select the desired print options, use Tab to move the insertion point 
to a value if you want to change it, and enter a new value. Or, move the pointer 
past an option you want to leave as it is. The following explanations may be 
helpful later when you enter print options for printing forms of your own: 

Print to 

This option allows you to print to your printer or to a disk file. FILE assumes 
that you typically print to your printer, so the Printer button is highlighted. To 
print to a disk file instead, click the Disk File button. Then type the name of the 
disk file in the next box you see. 

Print item names 

This option specifies whether or not the item names are to be printed along 
with the information in the items. If you do not want the item names printed, 
click the button until it is empty. : 
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Pause between pages 

If you click this option, FILE pauses after printing each page of information (as 
defined by the Lines per page option) so you can insert a new sheet of paper. 
This pause allows you to print forms on single sheet stationery, or print mailing 
addresses on individual envelopes. After each page is printed, a message 
prompts you to insert the next page. 

Lines per page 

This option specifies how many lines you want to have between the first line of 
one form and the first line of the next form. The default value of 66 is the full 
size of anormal printer page. You can adjust this value to accommodate the 
size of your printer paper and the size of your form. 

For example, if you want to print one form per printer page, and have printer 
paper with 66 lines, leave the Lines per page at 66. If you want two forms per 
printer page, change the Lines per page to 33. The number you enter should 
divide evenly into the total number of lines on your printer page, or your 
printing will cover the perforation. 

Number of copies 

This option specifies how many copies FILE prints of each form. If you specify 
more than one copy, FILE prints all copies of the first form, then all copies of 
the second form, etc. 

Printer codes 

You fill in this option to send codes to your printer to initiate or terminate special 
printing modes. For example, you might want to print your forms in 
compressed or bold type, since the Imagewriter printer has these print 
capabilities. See the section later in this chapter on “‘Using Special Printer 
Codes’’ for details. 

Note: FILE only temporarily stores any changes that you make in the print 
options. The next time you start the program, the default values are 
again in effect. The print options can be updated at any time. 

To continue with the example, move the pointer beyond the first line since you 
want to print to your printer. Click Print item names to clear the box, indicating 
that you do not want to print the item names on your mailing labels. Move past 
the Pause between pages option, since it is not necessary to change paper in 
this exercise. 
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Next, move the pointer to the Lines per page option. At this point, you need to 
determine the spacing between your mailing labels. (If you have questions 
about inserting paper or mailing labels, refer to your printer's reference manual 
or see your dealer.) 

6 lines 

For the mailing labels in this example, there are six lines from the start of one 
label to the start of the next. This is the number you want to enter in the Lines 
per page option, so change Lines per page to 6. 

Leave the Number of copies option as it is, and for now, leave the Printer 
codes option blank. Your window should look like this: 

@ File Edit Functions Formats 

Print to () Printer ©) Disk File 

[] Print item names [] Pause between pages 

Lines per page cea Number of copies ae 
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Finally, click the Ok button, and FILE stores the print options and moves to the 
third window you fill out before starting to print: 

" @ File Edit Functions Formats Help 

[_ Start printing || 

The third window also contains the form design. You use this window to specify 
which items you want to print, and the way you want them printed. (If you leave 
this form blank, each form is printed exactly as it appears on the window, using 
the print options you just selected.) The menu bar displayed with this window 
contains a Help menu. When the Help menu is pulled down, you see the 
commands that you can enter to set up the order and format for printing your 
forms. 

"_@ File Edit Functions Formats JET 

Sa cr Prints item ow 
i Print on same line .. "+" 
2] Fillin page 1 of the print format. Sort item ugn 

e Eaployee®- | 

A Job Title: 

e Salary: 



| 
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To select items for printing, use these two characters as defined: \ | () 

X Print this item; then advance the printer to the next line. 

“- Print this item, but do not advance the printer to the next line after 
printing it. Skip 2 spaces instead. (The plus sign allows you to print 
more than one item per line.) 

In addition, you can print the forms in a particular order by combining the 
following character with the X or +: : 

S Sort the printout based on this item. Using the first ten characters in 
this item, FILE sorts the printout into ascending order. You can sort 
on one item only. | 

LWW Wt 
Note: If your file is large, and you do not have an additional disk drive, you may 

not be able to sort your forms for printing. This is because FILE requires 
additional disk space in which to work during sorting. If you frequently 
need to sort, copy some of the forms to another file and sort each file 
separately. See Chapter 8 for details. 

For the purposes of sorting, FILE treats numbers as character strings. Just as 
AZ is sorted before Z, 19 is sorted before 9. For this reason, sorting the printout 
into numerical sequence is not feasible unless all the numbers are the same 
length, as with zip codes. To sort numbers of different lengths, enter zeroes to 
the left of the numbers to make them the same length. For example, 09 sorts 
before 19, not after. 

Note: Remember, an S does not automatically cause an item to be printed. It 
must always be used with an Xora +. 
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For this example, you want to select just the Name, Address, City, State, and 
Zip items for printing. Use the Tab key to move from item to item, and fill in the 
following information: 

" @ File Edit Functions Formats Help 

—————— EMPLOYEES —————————— 

Fill in page 1 of the print format. Start printing : 

Employee: 

siName: Xx 

gaAddress: <* 

City: + 

Job Title: 

#4 Salary: 

The + in City and State causes the item to print, but does not move the printer 
to the next line. The SX in Zip causes forms to be printed in numerical order 
based on the Zip item. Click the Start printing button, and FILE prints all the 
desired mailing labels. The mailing labels for the EMPLOYEES file look like 
this: 

Jennifer Young 

2421 Broadway 
Boston MA 02109 

John Andrews 

6811 Cypress Lane 

Dayton OH 45401 

Anne Williams 

67 Westlake Drive 

Los Altos CA 94022 
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When printing is complete, the window looks like this: 

" @ File £2:{ Functions Formats 

SS EMPLOYEES 

= 6 forms printed -- please make a menu selection. 

You are now ready to choose another command. 

Creating and Saving a Print Format for 
Future Use 
Next to the Functions menu on the menu bar is a menu titled Formats. The 

Formats menu looks like this: 

" € File £4:{ Functions 

Ss create a print format 
S : Primt TRis prini farrat 
| OTorms printed ~~ please! keawue this giint teria: 
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The Create a print format command allows you to specify the way you 
routinely want to print forms from a particular file, give a name to that format, 
and repeatedly use it to print forms by simply referencing its name. You can 
store eight formats in a file at one time. 

Let's create a print format to print the mailing labels you produced in the 
previous exercise. To select Create a print format, move the pointer to the 
Formats menu, pull down to the first command, and release. The first time you 
choose this command for the EMPLOYEES file, the following box appears: 

" @ File Edit Functions Formats 

| 6 forms printed -- please make a menu selection. : 

New format name 

lisence 

| Cancel | 

Enter a name of one to ten characters for the print format that you want to 
create. For this exercise, name the print format MAILABEL. Click Ok, anda 
print format window from EMPLOYEES appears. Fill in the items just as you 
did in the mailing label exercise. The print format and its name are 
automatically stored in the file to use for future printings. The next time you 
see the print options window, a new option appears: 
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" «@ File Edit Functions Formats 

Print to @ Printer ©) Disk File 

f] Print item names [] Pause between pages 

Lines per page Number of copies fey tg | 

@ Don't use predefined print format 

© MAILABEL 

(oe) 

Editing or Removing a Print Format 
To edit or remove a print format, pull down the appropriate choice from the 
Formats menu. For the EMPLOYEES file, the menu now looks like this: 

" @ File £4i¢ Functions Bigieey 

[SS create a print format 
Pris? PRES gephyed Tag ya’ 

Please make a menu seleq gecsocue this pring farmat 

Edit "MAILABEL" 
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To edit a format, choose the stored print format name from the Formats menu. 
FILE displays the stored print format. You can make changes by typing over 
any entries on the form, or you can choose Clear fields on the Edit menu to 
erase all the entries on that page of the print format and start over. 

To remove the print format from the file, pull down the Formats menu. Notice 
that the command Remove this print format is dimmed and therefore is not 
available. To make it available, first choose the command Edit ‘‘MAILABEL’’. 
When the print format appears, pull down the Formats menu again, and select 
the Remove this print format command which is now available. An alert box 
appears, giving you an opportunity to change your mind: 

" @ File Edit Functions Formats Help 

EMPLOYEES : 

| Edit page 1 of the print format "MAILABEL". : 

=] Employee? - 

T2) Remove this print format? 

If you go ahead and remove the print format, the next time you look at the 
Formats menu, you see that it has been removed. It is removed on the print 
options window, also. 

There is one other command on the Formats menu, Print this print format. 
To keep a hard copy record of the formats you have set up, choose this 
command and the format is automatically printed. 
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Printing with a Stored Print Format 
Using a stored print format for forms you routinely print saves one step in the 
printing process. When you use a print format, you do not enter format 
information item-by-item. Instead, you click the name of your print format on 
the print options window. Then when you click Ok to continue, the format 
window is skipped and FILE begins to print your forms with no further 
instructions. 

Canceling Print 
If at any time you want to stop printing, move the pointer to any menu and 
choose any command. Hold down the mouse button until the menu highlights. 
Doing so interrupts printing; however, if FILE is in the middle of printing a form, 
it finishes printing that form before stopping altogether. 

Using Special Printer Codes 
In the mailing label exercise you just completed, you used the standard print 
settings of your Imagewriter printer. However, your printer has other print 
capabilities that you may want to use in the future. To learn the complete range 
of your printer’s settings and the codes that control them, consult the 
Imagewriter owner’s manual. 

To use a Special setting, enter the necessary ASCII numbers in the Printer 
codes option on the print options window. When you finish the print sequence 
and tell FILE to start printing, the ASCII numbers you entered are sent to the 
printer, causing it to print in the special mode for as long as the printer is on. 

For this example, suppose that you want to set the printer to print in 
ultracondensed mode, or 17 characters per inch. The required ASCII number 
sequence Is 27 81. 
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First, choose the Print forms command from the Functions menu. At the first 
window, enter any search information necessary to select the forms you want 
to print. Click the Print forms button, and the print options window appears. 
Accept or change information as necessary, until you come to the Printer 
codes option. Type 27, press the space bar and then type 81. When you type a 
series of codes, be sure to follow each code with a space. (If you fail to leave a 
space, FILE ignores the entire code.) The screen should look like this: 

" € File Edit Functions Formats 

Print to @ Printer ©) Disk File 

Print item names [] Pause between pages 

Lines per page Number of copies ined 

Printer codes |2? $1 

@ Don't use predefined print format 

(> MAILABEL 

Now click the Ok button, enter print format information at the next window, and 
click the Start printing button. When printing begins, it is in ultracondensed 
characters. 

Turning Off Special Printing Codes 
Special printing codes remain in effect until you exit FILE and turn off your 
printer. If you wish to print again using a different printing mode, follow 
either of these procedures: 

a Simply turn your printer off and on again. Then enter the codes you wish to 
send for your next print (or leave the box empty if the default setting is 
satisfactory.) 

= Send another code which cancels the previous one, such as 27 34 to cancel 
boldface mode or 27 78 to return to Pica (10 characters per inch). 

In this chapter you have learned how to print information from a file, with or 
without using special print formats. The next chapter tells you how to change 
the design of a file. 

TTT 
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changing 

Rear 

After you have created and used your file, you may want to redesign the form 
to suit your needs better. With the Change design command on the Functions 
menu, you can add more items, delete some items, or rearrange the items of 
your form, whether your file is empty or contains data. Always be sure to make 
a backup copy of your file before beginning. 

Changing Design with a Single Disk Drive 
You can use FILE to change a design when you have no additional disk drives 
connected to your Macintosh, but the process requires available space on the 
disk that contains your file. If the disk does not contain available space equal 
at least to half the size of the file, you will not be able to change a design. 

Choosing the Change Design Command 
To use the Change design command, choose it from the Functions menu as 
you have done before. To continue the example, let’s redesign the 
EMPLOYEES form using the Change design command. 

If you are already working with the EMPLOYEES file, pull down the Functions 
menu and choose Change design. If you are not Currently using the 
EMPLOYEES file, return to the window listing the files by choosing the 
command Choose another file from the File menu and selecting 
EMPLOYEES from the list of files. Then choose Change design from the 
Functions menu. 
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The following alert box appears: 

" € File Edit Functions Formats 

| Please make a menu selection. 

iT?) The file will be changed by this operation. 

lf you do not want to change the design of your form now for some reason, you 
can click Cancel and choose another activity from the menus. To continue, 
click Ok, and the EMPLOYEES file appears as you originally designed it. The 
item names are no longer in boldface because they are no longer protected 
from overwriting. 

Guidelines for Changing Design 
When changing the design of a form, remember these points: 

= First makea backup copy of your file in case you change your mind later, or 
inadvertently damage the file during the redesign process. 

Leave enough space for the information in the item on the original form to fit 
into the item on the redesigned form. (See ‘‘Editing Data to Fit the New 
Design”’ in this chapter.) 

Only four pages (maximum) can be redesigned at one time. (See ‘“‘When 
the Form Has More Than One Page’’ in this chapter.) 

It may take a long time for FILE to reorganize your files. Depending on the 
complexity of the file and the amount of data in it, the reorganization can 
take from five minutes to a few hours. 
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s When transferring data, FILE looks for the item name first on the equivalent 
page of the new form, then on the other pages consecutively, so the data is 
transferred regardless of the page the item appears on. For example, in the 
redesign shown in the diagram below, the data in Item 3 now appears on the 
second page of the new form, while the data in Item 1 and Item 2 remains 
on the first page. 

OLD DESIGN NEW DESIGN 

ITEM 4: 

Adding, Deleting, or Moving Items 
When you are changing a form’s design, item names are no longer protected 

from being overwritten. You can type in new items, delete items by typing 

spaces over them, or move items. 

To move items on a single line, use the space bar or the Backspace key. To 
move an item elsewhere on the window, cut it from its original location and 
paste it into a new location. If you insert an item on a line containing other 
items, the current items are moved to the right. You may need to cut some 
space to restore the moved items to acceptable locations. 

Let’s delete the Salary item on the EMPLOYEES form and add an Experience 
item. Before you begin, make a backup copy of the EMPLOYEES file, if you 
have not already done so. 

Note: When you change the design of a form from a file that contains data, 
FILE assumes that it has temporary work space on the disk. If there is 
not enough room on the disk, FILE displays a message telling you that 
you cannot change the design of the form. 
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FILE displays the form from the EMPLOYEES file as you originally designed it: 

" @ File Edit Functions Formats 

: EMPLOYEES 

e Edit page 1 of the design. | Start changing | : 

oo 

aiEmployee®: 

SiJob Title: 
4 
ga Salary: 

To change the EMPLOYEES form, move the pointer down the window to the 
Salary item. Replace it by dragging across the item and typing Experience. 
Since you are not making any further changes, click the Start changing button 
to continue. FILE deletes the item named Salary along with its data and adds a 
new, blank item named Experience. 

WARNING: Although you will probably choose to cut and paste an item from 
one location to another on a form, you can also type it into a 
different position. If you do type an item, be very careful to spell it 
exactly as you first spelled it. If you do not, you will lose the data 
stored in that item on each form. 

Keep in mind these points when adding, deleting, or moving items: 

a Ihe item names in the old and new designs of the form must match exactly 
in order for the data to be copied. If they do not, FILE does not transfer the 
data belonging to the item to the redesigned form, and that data is 
permanently lost. For example, if the Name item on the PATIENT RECORDS 
form mentioned in Chapter 3 is moved to a new location during the redesign 

_ process, the line of dashes which is a part of the item name must also be 
moved, or the data belonging to that item cannot be transferred. (FILE 
ignores leading and trailing blanks when matching names, and treats more 
than one blank between words as a single blank. See Chapter 3 fora 

~ complete explanation of item names.) 



changing the design 7-5 

a You can move items to different places on the form without affecting the data for those items (as long as the names match exactly). 
a The redesigned form can have more or fewer items than the original form. When you delete items from the form, however, the data for those items is not copied. It is permanenily lost from the file. 

Entering Data in Redesigned Forms 
You can use the Find forms Command from the Functions menu to enter information in an item that you added to ] | each form appears on the wi 

now ready for you to make another menu selection. 

When the Form Has More Than One Page 
You can change only four pages of a multiple-page form at any one time. Thus, if you want to change six pages, you have to change four of them first, complete one of the redesign functions, then repeat the operation for the other two pages. 

Editing Data to Fit the New Design 
Sometimes when you transfer data from an Original form to a form with items moved to different places, the information in an item no longer fits into the Space provided on the redesigned form. FILE Stops and displays the following message: 



7-6 pfs:file 

" € File Edit Functions Formats 

| Changing design -- make a menu selection to stop. : 

JEmployee®: 16445 Hired: 80/08/12 

IT?) An item is too long. 

You have two choices. If only one form has an item that is too long, it is 
probably better to shorten the information in that item so that it fits in the new 
design. Or, if the form is not vital to the new file, delete it. 

If you click Ok, the form with the overlong data item appears with the pointer 
located at the first character that does not fit into the redesigned form. You can 
then edit the information in the overlong item. When you finish, click the 
Continue copy button to continue transferring data. 

lf many of the forms in the file have an item that is too long for the redesigned 
form, you might want to cancel the operation and redesign the form again to 
accommodate the data. Click the Cancel button in the alert box. FILE does not 
save the redesigned form. The file remains in its original state, and you must 
begin again. 

Changing the Order of Forms 
Since FILE recopies the forms starting with the last form entered in the file, 
Change design reverses their order in the file. If this reversed order is not 
acceptable for some reason (perhaps you search the most recently entered 
forms most often, and having them at the beginning of the file slows down the 
search process), choose the Change design command again, but this time do 
not make any changes to the form. Click Start changing to return the forms to 
their original order. 
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Removing a Blank Page 
When designing or redesigning a form, if you remove all the item names from 
a page, the blank page continues to exist. To remove the blank page, type the 
contents of the page following it onto the blank page, and so forth, until you 
have brought forward all subsequent pages. 

Canceling Change Design 
lf at any time you want to terminate Change design, move the pointer to any 
title on the menu bar and press the mouse button. In a few moments the 
menu title is highlighted. Pull down the menu and choose a command. FILE 
Stops changing the design and your form remains in its original state. 

This chapter told you how to change the design of a file, whether or not the file 
contains data. The next chapter is about copying part of a file to another file 
and about copying the design of a form to start a new file with the same form 
design. 
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copying forms 
: __ from the > fle 
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Once you have created a file and have information in it, you can copy part of 
the file or just the form design. You can start a new file with the same form 
design, divide one large file into two smaller files, or merge two files into one. 

There are two copy functions: 

1. Copy design only allows you to copy just the form design from the file. 

2. Copy forms allows you to choose among the filled-in forms in your file and 
copy these selected forms to another file. This option does not copy the 
form design. 

«= Choosing a Copy Command 
— To select a copy command, open an existing file and pull down the Functions 

menu to the command of your choice. Since FILE’s copy processes are each 
different, they are covered separately below. 

= Copying the Form Design Only 
= In the example that follows, you make a copy of the form design from the 

EMPLOYEES file. Later you can use the copied form design for another 
exercise. To begin, start up your Macintosh, if it is not already on, and open the 
EMPLOYEES file. At the Functions menu, choose the Copy design only 
command. 

Next, you see a box in which to name the new file. To avoid confusion, give the 
_ new file a distinct name like NEW EMPLOYEES. To keep you from 

unintentionally writing over an existing file with the copied form design, FILE 
displays an alert box if you try to give the new file the same name as another 
file on the disk. 

Click Ok, and the form design from the file is copied to a file named NEW 
EMPLOYEES. During the copy process, a message tells you that copying is 
under way. When it is over, you see the message, “‘Copy completed — please 
make a menu selection.’ 
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Although you have just created a file named NEW EMPLOYEES, you are still 
actually using the EMPLOYEES file. To use NEW EMPLOYEES, you must go 
to the File menu and pull down to Choose another file. At the next window, 
NEW EMPLOYEES appears in the list of files on the disk. Click Ok to begin 
using it. 

Suggestions for Using Copy Design Only 
With Copy design only, you can copy just the form design of an existing file to 
a new file (called the destination file). You use this command when your file 
becomes full, and you want to start a new file with the same form design. You 
also use it to provide a file with a form design before copying selected filled-in 
forms to it. 

Remember that selected forms must be copied to an existing file containing a 
form design. You can create a destination file by copying the form design using 
Copy design only first, or you can copy the selected forms to a partially-filled 
file. Note that the Copy design only option destroys any information that exists 
in the destination file. 

The layout of the forms from the source file and the destination file need not be 
identical (the items can be arranged differently), but the item names must be 
identical in order for information to be copied. For example, if your source file 
has an item called Employee Name, and the equivalent item in the destination 
file is called Name of Employee, the names of the employees are not copied. 

Copying Forms from the File 
The Copy forms option allows you to choose among the filled-in forms in your 
file and copy selected ones to another file. You might want to use this option 

when a file becomes too large and you want to split it into two files, or you might 

want to move a special interest group of forms to a new file. Also, you can use 

Copy forms to merge parts of several small files into one new file. 

Let’s copy some forms from EMPLOYEES to the file named NEW 
EMPLOYEES that you just created using the Copy design only command. 

With the file name EMPLOYEES in the window, choose Copy forms from the 

Functions menu. Next you see the following box, where you specify the file 
where the forms are to be copied: 
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B) 

” @ File Edit Functions Formats 

=| Please make a menu selection. 

Copy to file named 

NEW EMPLOYEES [ch _ PFS program 

Click NEW EMPLOYEES and Ok, and the blank EMPLOYEES form design 
appears. You are now ready to indicate which forms you want copied. Suppose 
you want to create a separate file for your California office, so you want to copy 
the forms for these employees to NEW EMPLOYEES. Type CA in the State 
item. Your window should look like this: 

" @ File Edit Functions Formats 

es 

Page 1 -- please choose forms to copy. | Start copying | : 

=] Emp loyee®: 

ice 
29 - 4 Name - 
od 

4 Address: 

| City: State: CA 

Job Title: 

24 Salary: 
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Click Ok, and FILE copies the appropriate forms from EMPLOYEES to NEW 
EMPLOYEES. Then the following window appears to show you how many 
forms were copied: 

" @ File £¢i{ Functions Formats ; 
SSS 0S —— 

aie ehieceitelats aeerace ete eleia ate letaleia b eateiels ratetetatatatenttes - USE chnncnnanimeeas 

Dividing a File 
When a file has grown in size, you may want to divide the file or split off part of 
it to form a new file. Or, you may want to separate a special interest group of 
forms to a new file. 

To divide a file, follow these steps: 

1. Copy the form design (using Copy design only) to a new file. If you change 
the design of the form in the new file, remember to keep the item names 
identical. FILE only copies information for items that have identical names. 

2. Use Copy forms to select and copy the filled-in forms you want into your 
new file. 

3: Select the Remove forms command and use the same search information 

to delete the copied forms from the original file. 
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Merging Files 
At some time, you may want to combine two small files into one, or parts of two 
or more files into one new file. For example, suppose you have two customer 
files (A to L and M to Z). You want to form a new file containing information for 
customers that have not made any purchases for the last three months. You 
can copy the form design from your present customer file, or design a new 
form that uses only some items from the present file. (Items that you do not use 
are not copied.) Then you can copy the filled-in forms (and the items) you want 
into the new file from the other two files. 

To merge files, follow these steps: 

1. Before merging files, make sure you estimate their combined size so that 
you do not exceed the storage capacity of the disk used (see Appendix B). 

. Use a file that already has a form design, or create a new file by copying a 
form design or designing a new form. If you do not want some items to be 
copied to your new file, do not include the names of those items in the new 
form design. Make sure that item names are identical for items that you do 
want copied. 

. Use Copy forms to select and copy the filled-in forms you want into your 
new file. 

Canceling Copy 
lf at any time you want to terminate a copy process, move the pointer to a menu 
on the menu bar and pull down a selection. (Hold down the mouse button until 
the menu highlights.) If you do so while FILE is copying, however, the 
destination file receives only the information transferred from the source file 
before you pulled down a selection. 

This chapter has been about copying forms and form designs. The next 
chapter tells how to remove selected groups of forms from a file. 
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There are two ways to remove forms you no longer want from your file. First, when you are working with a particular form, you can remove just that form by choosing Remove this form from the Functions menu. Second, you can remove all of the forms or a group of forms by selecting Remove forms. In this case, you indicate which forms you want to remove, and FILE searches, removing the appropriate ones. (To see each form before it is removed, use the Find forms command as explained in Chapter 5.) 

Choosing the Remove Forms Command 
To use the Remove forms command, open an existing file and choose the Remove forms command from the Functions menu. The form design appears, and you fill in search information to identify the forms you want to remove. 

Removing Selected Forms 
Let's try removing forms from the EMPLOYEES file. Since you have created a separate file for the California sales office, you now want to remove any California employees from the EMPLOYEES file. First, start FILE as you have done before, and select the EMPLOYEES file. Choose the Remove forms command from the Functions menu. 

The blank EMPLOYEES form design appears with the message ‘Page 1 — please choose forms to remove’ in the message line. Using the Tab key, move to the State item. Enter CA to indicate that you want to remove all California employees’ forms. The window should look like this: 
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@ File Edit Functions Formats 

EMPLOYEES 

Page 1 -- please choose forms to remove. Start removing 

Next, click the Start removing button, and FILE displays the following 
message, giving you the opportunity to change your mind before it removes 
any forms: 

@ File Edit Functions Formats 

ip Remove the chosen forms? 

Ce Gear 
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Click the Ok button to proceed, and FILE removes all forms with CA in the 
State item. When it finishes, you see this message: 

" @ File £4¢ Functions Formats 

| 3 forms removed -- please make a menu selection. - 

Note: Removing a form involves erasing information from your file. Before 
FILE removes any forms, it gives you the opportunity to change your 
mind. If you click Cancel, FILE removes no forms. If you click Ok, FILE 
removes all the forms matching the search information you entered. 
After the last form is removed, FILE displays a message, indicating the 
number of forms that have been removed. 

Once a form is removed, the disk space previously occupied by the form is 
automatically reused as soon as FILE stores another form. 

Removing All Forms 
lf you want to remove all forms from a file, leave the form blank, and click the 
Start removing button. FILE tells you that it is about to remove all forms, and 
gives you a chance to change your mind. 

lf you change your mind at this point, click Cancel to stop the process. 
Otherwise, click Ok, and FILE removes all the filled-in forms, leaving just the 
form design in the EMPLOYEES file. 

Note: Even when the file contains no forms, the design remains. The only way 
to remove a file from the disk is to use the Finder to throw it in the trash, 
and then empty the trash. 
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Canceling Remove Forms 
You can decide not to remove the forms you have selected. If the dialog box is 
displayed, simply click Cancel and no forms are removed. Your file is left intact. 
If the dialog box is not yet displayed, you can stop the Remove forms process 
by choosing another command. In this instance, move the pointer to any menu 
and choose any command. No forms are removed. 

In this chapter you have learned to remove forms from a file. Return to any of 
the preceding chapters when you need suggestions on creating and 
maintaining your own file. Turn to the Quick Guide to PFS:FILE for quick 
reminders on using the program. 
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PFS:FILE displays a message whenever it encounters an error condition. 
Certain errors are the result of mistakes made when you entered information 
(such as filling in Print forms or Copy forms information). Other errors are the 
result of physical limitations or problems with certain elements of your 
Macintosh. Error messages are displayed like this: 

" @ File Edit Functions Formats 

. #}Employee®: 16445 Hired: 80/08/12 

In most cases, error messages are displayed in alert boxes with buttons you 
click to indicate your choice of action. For further explanation of errors and 
suggested solutions, refer to the alphabetical list below. 
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Message 

An item is too long 

Can’t print to your PFS 
data file 

Clipboard contents are 
too big to fit in memory 

lO error 

Corrective Action 

When transferring data from an original form to a 
redesigned form, an item does not fit into the 
space set aside on the redesigned form. Either 
edit the information in the overlong item or 
redesign the form. 

You tried to print to a disk file using the same 
name as the PFS file you are printing from. FILE 
does not allow you to replace the existing data 
file with a disk file. Enter a different name for the 
disk file. 

FILE cannot be loaded into memory because the 
contents of the Clipboard are too big. If you click 
Ok, FILE continues loading into memory, but the 
contents of the Clipboard are erased from 
memory in the process. If you click Cancel, you 
return to the Finder. Use another application to 
edit the contents of the Clipboard before loading 
FILE. 

lt is unlikely that you will see the IO error 
message. If you do, it is a result of a system 
problem involving either your Macintosh or your 
disk or both. Begin using your most recent 
backup disk immediately. Check the section “‘lf 
Something Goes Wrong” in your Macintosh 
owner’s guide for solutions to problems with the 
Macintosh. If |O error persists, see your Apple 
dealer. 

Only 4 pages can be 
changed at one time 

You have tried to change the form design of more 
than four pages of the form at one time. 
Complete the redesign process for no more than 
four pages of a form design at once. Repeat the 
process for each additional four pages. 

Remove all of the forms? This message gives you a chance to change 
your mind when you tell FILE to remove all forms 
from a file. Click Ok to proceed or Cancel to stop 
the process. 

Ila 



Message 

Remove the chosen 

forms? 
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Corrective Action 

You have the opportunity to stop removing the 
forms you chose by clicking Cancel. You can 
specify different forms to remove or correct your 
original search information by choosing Remove 
forms from the Functions menu again and 
starting over. | 

SS 

Remove this form? Once you have located a form using the Find 
forms command, you can remove it, edit it, or 
print it. To prevent removal of forms accidentally, 
this message appears. Click Ok to remove it or 
Cancel to keep it in the file. 

—_——: 

Remove this print 
format? 

To prevent removal of a print format accidentally, 
this message appears when you choose 
Remove this print format. Click Ok to remove it 
or Cancel to keep it in the file. 

—_—... 7K 

The data file is at 

maximum size 
You have attempted to add a form to a file that 
has reached the maximum size of four 
megabytes. Use the Copy design only 
command to copy the design to a new file and 
add forms to the new file. 

-_— CC le OoOcOWVO0O 

The disk is full FILE attempted to write to the file and found that 
there was no room on the disk. If you have some 

~ unnecessary forms in the file, make space by 
removing them (see Chapter 9). If the disk has 
an unneeded file, you could remove it, or copy it 
to another disk. You could also use the Copy 
design only command to copy the design from 
the current file to a new file, then continue adding 
information to the new file. 

Cc eco 

The disk is 
write-protected 

FILE cannot use disks that are write-protected 
(or locked). FILE uses certain areas of the disk to 
store temporary information, even when you 
select Find forms or Count forms. To correct 
this situation, slide the red disk tab to cover the 
hole. 
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Message 

The file will be changed 
by this operation 

The PFS data file is 

broken 

Unable to create the work 

file 

Use fewer characters to 

choose forms 

Corrective Action 

Your file and the data it contains will be changed 
during the Change design process you are 
about to undertake. Make a backup copy before 

~ continuing, in case you don’t like the results of 
the design change or in case you lose data. 

Broken data files are the result of several 
possible factors: power fluctuations, excessive 
heat exposure to the disk, magnetic fields near 
drives, etc. Begin using your most recent backup 
immediately. 

There is insufficient space on the disk to use for 
temporary storage when changing design, 
copying selected forms, or when sorting forms 
for printing. Remove or copy files to another disk 
to release space equal at least to half the size of 
the file you are using. 

The search information you entered will not fit in 
FILE’s internal storage area. Specify search 
information with fewer characters. 
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disk storage 
Capacity 

SSS SSS rire esse 

A standard, single-sided disk can hold up to 2900 very simple forms, assuming 
there is only one file on the disk, although the actual number of forms that will 
fit on a particular disk depends on the amount of available space, how many 
pages there are in the form, how many items there are per page, and how 
much data is entered in each item. For example, the form for an average 
mailing list would only allow about 1500 forms on one single-sided disk, 
assuming that the file was the only file on the disk. 

A file is divided into blocks of 128 bytes (characters) per block. Some of this 
space is used to store the form design, directory information and other internal 
information. 3100 of these 128-byte blocks, ona single-sided disk, are used to 
store your information. 

Each page of every form stored in a PFS:FILE data file uses at least one 
128-byte block, even if the page is blank. The actual number of forms that you 
can fit into one of your files is a function of how much data is entered in each 
individual form. 

Use the following rules to estimate how many bytes are used by a page of a 
form: 

PFS:FILE uses the first 14 bytes of every page. 

Each item name entered on a page takes 5 bytes (FILE internal parameters). 

Each character entered in an item takes one byte. 

Each blank space in a filled-in item takes one byte, but no blanks are 
counted at the beginning or end of an item. 

A string of three or more blanks inside a filled-in item takes three bytes, as 
shown in the following example. 

NAME: Jeff Stribling 1970 
5 -F4 +] #9 +3 +4 #£,= 26characters 

A blank item takes six bytes (five for the FILE internal parameters plus one 
blank character). 
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After figuring the total number of bytes used by each page of a form, use these 
steps to estimate how many forms will fit in a file: 

a Divide the total number of bytes for a page by 128. 

=» Round upto the next largest whole number. (This gives you the number of 
128-byte blocks used by the page.) 

Add the number of blocks for all pages of the form to give you the total 
number of blocks required for an average form. 

Divide the total number of blocks on your disk used to store data (3100 for 
single-sided) by the total number of blocks required by one form. 

Multiply the result of your calculations by twelve-thirteenths to arrive at the 
approximate number of forms you can fit on the disk. 

It is necessary to figure page by page because FILE uses space on a per-page 
basis. For example, if you use 30 bytes on a page, FILE assigns 128 bytes to 
that page in that file, and those 98 empty bytes are not used anywhere else. 
Estimating an entire form at once, instead of each page individually, will cause 
you to think that you have more empty space in your file than you actually do. 
Let’s use the following example to estimate space on a form: 

&@ File Edit Functions Formats 

SS = PHONE LIST a 

a 

Fill in page 1 of the new form. [ Continue adding] : 

#4Maqme-: Anastasia C. Doerr 

o Home Phone: 408-923-8269 

Z 
Business Phone: 

se Address: 130 Piazza Way 

ACity: San Jose Zip: 95127 
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14 - FILE uses the first 14 bytes ona page 
35 - 7 items using 5 bytes each (FILE internal parameters) 
19 - Anastasia C. Doerr = 17 characters, 2 spaces 
12 - 408-923-8269 = 12 characters, O spaces 
1 - Business Phone: empty item = 1 space 

14 - 130 Piazza Way = 12 characters, 2 spaces 
8 - San Jose = 7 characters, 1 space 
2 - CA = 2characters, 0 spaces 

S - 95127 = 5 characters, 0 spaces 
_—_— 

110 - TOTAL number of bytes used by this form 

110/128 = .86 Step 1. The total number of bytes for the page 
divided by 128. 

Step 2. Round .86 up to the next largest whole 
number, which is 1. 

Step 3. Since this form has only one page, 
there is nothing to add to the 1. This form will 
require one storage block. 

3100/1 = 3100 Step 4. Divide the total number of blocks on 
your disk (3100 for single-sided) by the total 
number of blocks required by one form. 

3100 x 12/13 Step 5. Multiply the result of your Calculations by 
12/13 to determine the number of forms you can 
store. 

If you put more than one FILE data file ona disk, they will compete with each 
other for space until the disk is full. When a file is initially built, ittakes 128 
blocks of 128 bytes each, for a total of 16384 bytes. When that space is used, it 
takes space 64 blocks at a time, as it needs more room. To find out how much 
space is available on a disk, check the directory line at the top of the data disk 
window. 
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al Keys 

Enter 

Backspace 

Confirms whatever entry you’ve made on a window so that 
FILE moves on to the next step. In an alert box, it is the same 
as Clicking the heavily outlined button (like Ok, for example). 

Moves the insertion point to the beginning of the next line. In 
an alert box, it is the same as clicking the heavily outlined 
button (for example, Cancel). 

Moves the insertion point to the next item on the form. With 
the Shift key pressed, Tab moves the insertion point back to 
the previous item on the form. On the print options window, 
pressing Tab moves the insertion point from box to box and 
highlights text so that you can type over it if you wish. 

Moves the insertion point to the left one space and erases the 
character in that location. 

Lets you enter accented and special characters. Refer to 
Appendix A of your Macintosh owner’s guide. 

Used in combination with the following keys: 

Cuts highlighted text and places it on the Clipboard. 

Copies highlighted text and places it on the Clipboard. 

Pastes text from the Clipboard at the insertion point on your 
screen. \s 

Pastes current time at the insertion point. 

Pastes current date at the insertion point. 
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Creating a File 

Steps 1. Click the New button on the PFS:FILE title window to 
create a new file. Eject the disk, if necessary, and insert 
a data disk. 

. Type aname for the new file at the next window and 
click Ok. 

Type in the design, following these guidelines: 
Make the first item the one you will search for most 
frequently. 
Place a colon at the end of each item name. 
Leave plenty of space for each item. 
To design additional pages of the same form, press the 
down scroll arrow and continue typing items. 
Maximum # of items per page = 100 
Maximum # of pages per form = 32 
FILE stores the form as you design it. 

Adding Information to the File 

Steps 1. Choose Add forms from the Functions Menu. 

2. Fill in the form (all pages). 
3. To add another form, click the Continue adding 

button. 

4. Click the down scroll arrow to create an attachment 
page for the form you are adding. ¢ 

Copying from the File 

Options 1. Choose Copy design only from the Functions menu 
to copy the form design to a new file. 

2. Choose Copy forms from the Functions menu to copy 
selected filled-in forms from a file to another existing 
file (particularly useful for splitting or merging files). 
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a Items must have identical names to be copied from 
one file to another, but they do not have to be in the 
same location on the two forms. 

= Before merging files, estimate their combined size so 
you will not exceed the storage capacity of the disk. 

search Information 
a a 

If you enter: FILE will find: 

abc abc only (upper or lower case) 
..XYZ Any entry ending xyz 
abc.. Any entry starting abc 
_ Pats Any entry containing par 
fe Any nonblank entry 
?and Any four-letter word ending with and (band, land, etc.) 
<10 Any number less than 10 
=99. Any number greater than 99 
= 33 The number 33 
= {5 Any number between 1 and 5 
/=25 Any number not equal to 25 
/A.. Any entry not starting with A 
is Any blank entry 
es a 
Printing Forms 

Options a Use Print forms from the Functions menu to print a 
copy of all or part of a form. 

= Use Create a print format from the Formats menu to 
create a set of print instructions and store them for 
repeated use (maximum eight print formats per file).. 
ec 

1. Fillin search information to tell FILE which forms in the 
file you want printed. 

2. Fill in the print options window to tell FILE how you 
want the information printed. (If you enter the name of 
a pre-defined print format in the print options window, 
the third print window does not appear.) 
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3. Fill in the third print window with format instructions 
that tell FILE which items in the form to print, whether 
to put items on the same or a different line, or whether 
to sort the forms according to a certain item. 

Print 
| a Use these characters to fill in the print format: 

Specifications 
a X print this item and advance the printer to the next line. 
a+ print this item but do not advance the printer to the 

next line - skip 2 spaces instead. 
aS sort printout based on this item. 

If you do not enter any print information, FILE prints 
forms just as they appear on the screen. 
FILE always prints items in the same relative order in 
which they appear on the form. 

Changing Design 

Steps 1. Make a backup copy before you change the form. 
2. Item names in the redesigned form must match exactly 

the item names in the original form, but can be in 
different places on the forms. 

. Leave enough space for the information in an item on 
the original form to fit into the item on the redesigned 
form, or edit the information to fit. 

. Only four pages of a multiple-page form can be 
changed at one time. 

With a single disk drive, and if a disk does not contain 
available space equal to at least half the size of the file, 
you cannot use Change design. 



Apple menu 
arrow, Scroll 

backup disk 
Backspace key 
button 

Cancel button 
care of disks 
Change design command 
change 

choose a menu command 
Clear fields command 
click 

Clipboard 
Close All command 
close box 
colon . 

Index-1 

index 
ae eae ee re ee ee ee eee eee ee eee eee eee 

Command keys 
confirm entry See Return and 
Enter keys and Ok button 

Copy command 
Copy design only command... . 
Copy forms command 
copy See Copy and Paste 
commands 

Count forms command 
Create a new file command .... 
Cut command 
to move text 

delete See remove, Backspace 
key, and Cut command 

design hints 
desk accessories 
dialog box 
dimmed command 
directory window 
disk 

storage capacity 
disk drive 

hard disk unit 
double-click 

adjust speed of 
drive, disk See disk drive 

$e 
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Edit menu 

edit text 

Eject 

command 
Enter key 
erase See remove, Backspace 
key, and Cut commands 

error messages 
equipment 

File menu 

file names 
Find forms command 
Finder 
Formats menu 
format See initialize a disk 
full-item search 

Functions menu 

Help menu 
highlighted command 

icon 

double-click 

Imagewriter printer . 
initialize a disk 
insert 

insertion point 
item name - 

keyboard 
adjust touch 
special FILE keys 

locked disk 

lower case letters . 

magnetic fields 

menu See also specific 

dimmed command 

pull-down 
select from 

move 
pointer 

multiple page 

‘Not’ search 
numeric item search 

numeric range search 

Ok button 
open 
existing file 
new file 

Option key 
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XK 

Pp 

partial item search 
Paste command 
to copy text 
to move text 

save for future use 
Print forms command 
Print this form command 
Print this print format 

print options 
printer codes 

print 
selected groups of forms 
stop 

spare copy 
protecting data files 

Q 

Quit PFS:FILE command 

R 

recover removed items 
See Undo changes command 

remove See also Backspace key, 
Cut, and Clear fields commands 

Remove forms command 
Remove this form command ... 
Remove this print format 
command 3 

replace text 
Return key 
return to Finder 

scroll box 

select See also click 

shaded icon 
Show Clipboard command 
start FILE 

Undo screen changes 
command 

upper case letters 
Use an existing file command . . 2-3 

W 

warning See alert box 
window 
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